Important Safety Information

WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes. Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified service personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small children to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Trademarks

Epson and Instant Off are registered trademarks and Epson Exceed Your Vision and Easy Management are trademarks of Seiko Epson Corporation.

PowerLite and PrivateLine are registered trademarks; SizeWise is a trademark; and Epson Store and Extra Care are service marks of Epson America, Inc.

Pixelworks, DNX, and the DNX logo are trademarks of Pixelworks, Inc.

AMX is a trademark of AMX Corporation.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

The contents of this manual are subject to change without notice.
## Contents

### Welcome
- Getting the Most from Your Projector .................................................. 9
- Using Your Documentation ........................................................................ 11
  - Getting More Information ........................................................................ 11
- Registration and Warranty ......................................................................... 12
- Unpacking the Projector ............................................................................ 13
  - Additional Components ........................................................................... 13
  - Optional Accessories ............................................................................. 14

### Setting Up the Projector
- Positioning the Projector ........................................................................... 15
- Connecting to Video Equipment ................................................................. 18
  - Connecting a Composite Video Source .................................................... 19
  - Connecting an S-Video Source ................................................................ 20
  - Connecting a Component Video Source ................................................... 21
  - Connecting an RGB Video Source ............................................................ 22
- Connecting to a Computer .......................................................................... 24
  - Connecting to the Computer Port ............................................................. 25
- Connecting an External Monitor ................................................................. 26
- Playing Sound Through the Projector ......................................................... 27
  - Connecting Audio Equipment to the Projector ....................................... 27
  - Connecting External Speakers ................................................................. 28
2 Projecting .......................................................... 29
  Turning On Your Equipment .................................. 30
    Turning On the Projector .................................. 30
    Selecting the Image Source ................................ 32
    What To Do If You See a Blank Screen ................. 33
  The Projector and Notebook Don’t Display the Same Image .................................................. 33
  Adjusting the Image .......................................... 35
    Focusing and Zooming Your Image ...................... 35
    Adjusting the Height of Your Image ................... 36
    Adjusting the Image Shape ............................... 37
    Correcting Computer Images ............................ 38
  Adjusting the Volume ....................................... 38
  Shutting Down the Projector .............................. 39

3 Using the Remote Control ................................. 41
  Using the Remote Control ................................. 42
    Using the Navigation Buttons ........................... 42
    Replacing the Batteries ................................ 43
  Controlling the Picture and Sound ...................... 44
    Switching Between Picture Sources .................... 44
    Turning Off the Picture and Sound .................... 44
    Stopping Action ........................................... 45
    Zooming Your Image .................................... 45
    Changing the Image’s Aspect Ratio ..................... 46
  Highlighting Your Presentation ......................... 46
    Using the Pointer Tool .................................. 46
    Changing the Pointer Shape ........................... 47
  Operating Two or More Projectors with the
    Remote Control ........................................... 47
    Setting the Projector ID ................................. 48
    Setting the Remote Control ID ......................... 48
4 Configuring the Projector

Using the Menu System

Restoring the Default Settings

Adjusting Colors and Clarity

Adjusting the Input Signal

Customizing Projector Features

Selecting Projector Setup Options

Selecting Network Settings

Viewing Lamp Usage and Other Information

Using the Projector’s Security Features

Creating Your Own Screen Logo

Displaying Your Screen Logo

Setting a Password

Protecting Projector Settings

Turning On Password Protection

Starting the Projector with a Password

Disabling the Projector’s Buttons

5 Monitoring the Projector Over a Network

Installing the Network Software

System Requirements

Installing the Software

Connecting to the Network

Selecting Network Settings

Using Projector E-mail Alerts

Using EMP Monitor

Opening and Closing EMP Monitor

Registering a Projector

Monitoring Your Projectors

Using E-mail Alerts

Using a Browser to Monitor the Projector
Maintaining the Projector

Cleaning the Lens Cover Glass
Cleaning the Projector Case
Cleaning the Air Filter
Replacing the Air Filter
Reseting the Air Filter Timer
Replacing the Lamp
Reseting the Lamp Timer
Transporting the Projector

Solving Problems

Using On-Screen Help
Checking Projector Status
What To Do When the Lights Flash
Viewing Lamp Usage and Other Information
Solving Problems with the Image or Sound
Solving Password Problems
Solving EMP Monitor Problems
Solving Problems with the Remote Control
Where To Get Help
Internet Support
Speak to a Support Representative
Purchase Supplies and Accessories

Projector Installation

Installation Guidelines
Installing the Rear Cable Cover and Lock

Technical Specifications
Welcome

The PowerLite® 6110i is a versatile projector designed to ensure that your presentations are easy and trouble-free, whether you use it in the classroom or conference room. When space is limited, you can project against a surface less than two and one-half feet away. The projector’s keystone correction function allows you to correct image distortion. In addition, the PowerLite 6110i offers outstanding image quality, with up to 3500 lumens of brightness, a resolution of 1024 × 768 pixels, and a 600:1 contrast ratio.

Your PowerLite projector can be connected to two computer video sources at the same time, or four video sources. You can include an independent sound channel for each source.

Use the remote control to take charge of your presentation. Freeze the action or zoom in on part of the picture. You can also use the remote as a pointer, or to draw on the screen.

With the projector’s Easy Management™ software, you can use a Windows® PC to remotely monitor and control the projector.

To prevent unauthorized use of your PowerLite 6110i, you can assign a password, create a user logo which is displayed at startup to identify the projector, and disable the projector’s buttons through the Operation Lock feature. For more information about security features, see page 65.
Getting the Most from Your Projector

Depending on your presentation, you can take advantage of any or all of these options:

- **Connecting to a notebook or other computer**
  If you want to connect the projector to a notebook or desktop computer, see page 24. For additional presentation control, you can connect an external monitor to view the presentation on your computer simultaneously.

- **Connecting to video sources**
  You can connect a Blu-ray™ HD-DVD®, or DVD player, VCR, HDTV tuner, camcorder, laser disc player, digital camera, and other video sources to your projector. See page 18 for instructions.

- **Using the remote control**
  The remote control lets you switch from computer to video sources, zoom in on part of your image, freeze or mute the presentation, and adjust many other projector features. For details, see Chapter 3.

- **Including sound in your presentation**
  If your presentation includes sound, you can connect an optional audio cable to the projector to use the projector’s built-in speaker. See page 27.
Using Your Documentation

Your documentation includes a Quick Setup sheet, warranty brochures, and an Epson® PrivateLine® Support card.

The Quick Setup sheet gives instructions for setting up and connecting your projector to a notebook computer.

This book contains all the information you need to set up and use your projector. Please follow these guidelines as you read through it:

■ Warnings must be followed carefully to avoid bodily injury.
■ Cautions must be observed to avoid damage to your equipment.
■ Notes contain important information about your projector.
■ Tips contain additional projection hints.

Getting More Information

Need tips on giving presentations? Quick steps for setting up your projector? Here’s where you can look for help:

■ presentersonline.com
  Includes a library of articles covering presentation tips, tricks, and technology. The site provides templates, clip art and sound clips, as well as Presenters Services to use on the road. Even more resources and services are available if you register to join the Presenters Club—and it’s free.

■ built-in help system
  Press the Help button on the remote control or projector to get quick solutions for common problems. See page 94 for details.

■ epson.com/support
  Download FAQs (frequently asked questions) and e-mail your questions to Epson support.

If you still need help after checking this User’s Guide and the sources listed above, you can use the Epson PrivateLine Support service to get help fast. Call (800) 637-7661 and enter the PIN on your PrivateLine Support card. See page 106 for more information.
Registration and Warranty

Your projector comes with a basic carry-in warranty. For details, see the warranty brochure included with your projector.

In addition, for customers who register their projector, Epson offers free Extra CareSM Road Service. In the unlikely event of an equipment failure, you won’t have to wait for your unit to be repaired. Instead, Epson will ship you a replacement unit anywhere in the United States or Canada, usually via overnight delivery. See the Extra Care Road Service brochure for details.

To register, simply insert the projector CD and select Register Your Product. Or you can register online at:

epson.com/webreg

Registering also lets you receive special updates on new accessories, products, and service.
Unpacking the Projector

After unpacking the projector, make sure you have all the parts shown below:

Save all packaging in case you need to ship the projector. Always use the original packaging (or the equivalent) when you need to send the projector to another location. If you are moving the projector by hand, use a carrying case. See page 91 for transportation instructions.

Additional Components

Depending on how you plan to use the projector, you may need additional components:

■ To receive an S-Video signal, you’ll need an S-Video cable. One may be provided with your video equipment, or you can purchase one from Epson; see page 14.

■ To receive a component video signal from a VCR or other video device, you’ll need a component-to-VGA video cable. One may be provided with your video equipment, or you can purchase one from Epson; see page 14.
**Optional Accessories**

To enhance your use of the projector, Epson provides the following optional accessories:

<table>
<thead>
<tr>
<th>Product</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacement lamp</td>
<td>V13H010L45</td>
</tr>
<tr>
<td>High efficient air filter (standard)</td>
<td>V13H134A11</td>
</tr>
<tr>
<td>Smoke filter</td>
<td>V13H134A12</td>
</tr>
<tr>
<td>Ceiling mount</td>
<td>ELPMBUNI</td>
</tr>
<tr>
<td>Suspension adapter</td>
<td>ELPMBAPL</td>
</tr>
<tr>
<td>False ceiling plate</td>
<td>ELPMBFCP</td>
</tr>
<tr>
<td>Adjustable ceiling channel</td>
<td>ELPMBACC</td>
</tr>
<tr>
<td>Security bracket/cabling</td>
<td>ELPMBSEC</td>
</tr>
<tr>
<td>Kensington® security lock</td>
<td>ELPSSL01</td>
</tr>
<tr>
<td>Projection screens:</td>
<td>ELPSC06</td>
</tr>
<tr>
<td>50-inch portable screen (4:3 aspect ratio)</td>
<td>ELPSC07</td>
</tr>
<tr>
<td>60-inch portable pop-up screen (4:3 aspect ratio)</td>
<td>ELPSC08</td>
</tr>
<tr>
<td>80-inch portable pop-up screen (4:3 aspect ratio)</td>
<td>ELPSC09</td>
</tr>
<tr>
<td>83.6-inch hanging pull-down screen (4:3 aspect ratio)</td>
<td>ELPSC09</td>
</tr>
<tr>
<td>S-Video cable</td>
<td>ELPVS01</td>
</tr>
<tr>
<td>Component video cable, 9.8 ft (for mini D-Sub 15-pin/RCA×3)</td>
<td>ELPKC19</td>
</tr>
<tr>
<td>Distribution amplifier</td>
<td>ELPDA01</td>
</tr>
<tr>
<td>ELPDC05 high resolution document imager</td>
<td>V12H162020</td>
</tr>
</tbody>
</table>

You can purchase these accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at [www.epsonstore.com](http://www.epsonstore.com) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales).
Setting Up the Projector

This chapter gives you basic information on setting up the projector: where to position it and how to connect it to a video source (such as a VCR or DVD player) or to a notebook or desktop computer.

Follow the instructions in this chapter on:

- Positioning the projector
- Connecting to video equipment
- Connecting to a computer
- Connecting an external monitor
- Playing sound through the projector
Setting Up the Projector

Positioning the Projector

If you’re setting up the projector yourself and it isn’t already installed in the classroom or conference room you’re using, you’ll probably want to place it on a table in front of the screen, as shown on page 17.

This lets you stand in the front of the room, face the audience, and remain close enough to the equipment to be able to control it. Try to leave as much space as possible between the projector and the screen to get a good-size image.

Use the figure below to help you determine placement. Image size increases with distance, but can vary depending on how you position the zoom ring and whether you’ve adjusted the image with other settings.

Also keep these considerations in mind:

- Place the projector on a sturdy, level surface.
- Make sure there is plenty of space for ventilation around and under the projector. Do not set the projector on top of loose papers that could block the vents under the projector.
- Make sure the projector is within 10 feet of a grounded electrical outlet or extension cord.

note
You can mount the projector on the ceiling, or place it behind a translucent screen for rear projection. See page 109 for details.
Ideally, you should place the projector directly in front of the center of the screen, facing it toward the screen squarely. The lens should be at about the level of the bottom of the screen.

If you place the projector below screen level, you’ll have to tilt it up by extending its feet. This causes the image to become “keystone” shaped, but you can correct the distortion by pressing the ▼ or ▲ buttons on the projector. See page 37 for detailed information about correcting the image shape.

For instructions on installing the projector in a permanent location, such as a classroom or conference room, see page 109.

**note**

*After positioning the projector, you may want to connect a Kensington MicroSaver® anti-theft device to the lock port on the projector’s left side. You can purchase this from Epson; see “Optional Accessories” on page 14.*

*You can also connect a commercially available anti-theft cable and lock to the metal bar on the bottom of the projector.*
Connecting to Video Equipment

You can connect up to four video sources to the projector at the same time. Before starting, look at your video equipment to determine its available video-output connections:

- If your video player has a yellow RCA-style video output connector, see “Connecting a Composite Video Source” on page 19.
- If your video player has an S-Video connector, see “Connecting an S-Video Source” on page 20.
- If your video player has a component video port (three connectors labeled either Y/Cb/Cr or Y/Pb/Pr), see “Connecting a Component Video Source” on page 21.
- If your video player has an RGB video port (either a single connector for a VGA-style monitor cable, or three connectors labeled R/G/B), see “Connecting an RGB Video Source” on page 22.

After connecting the video cables, you may also want to connect an audio cable to play sound through the projector; see page 27.
Connecting a Composite Video Source

1. Locate an RCA-style composite video cable (one may be included with your video equipment).

2. Connect the cable to the yellow video output connector on your player and the yellow Video connector on the projector:

3. If you want to play sound through the projector, see page 27 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see Chapter 2 or the Quick Setup sheet for instructions on turning on the projector and adjusting the image.
Connecting an S-Video Source

1. Locate an S-Video cable (one may have been provided with your video equipment, or you can purchase one from Epson; see page 14).

2. Connect the cable between the S-Video connector on your player and the S-Video connector on the projector:

3. If you want to play sound through the projector, see page 27 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see Chapter 2 or the Quick Setup sheet for instructions on turning on the projector and adjusting the image.
Connecting a Component Video Source

1. Locate a component-to-VGA video cable (you can purchase one from Epson; see page 14).

2. Connect the RCA end of the cable to your player and the VGA end to the Computer1 port on the projector.

3. If you want to play sound through the projector, see page 27 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see Chapter 2 for instructions on turning on the projector and adjusting the image.

5. Once the projector is turned on, enter the projector’s Signal menu and make sure Computer1 is set to Auto; see page 56.
Connecting an RGB Video Source

Follow these instructions to connect the projector to a video player that has an RGB video output port. Depending on the type of connector on your player, you’ll need to use the appropriate cable:

- If your player has a VGA-style connector, follow the steps below.
- If your player has three BNC connectors labeled R/G/B, see “Connecting Using a BNC-to-VGA Cable” on page 23.

Connecting Using a VGA-style Computer Cable

1. Locate the VGA computer cable provided with the projector.
2. Connect the cable between the video port on your player and the Computer1 port on the projector.
3. If you want to play sound through the projector, see page 27 for instructions on connecting an audio cable.
4. If you don’t need to make any other connections, see Chapter 2 for instructions on turning on the projector and adjusting the image.
5. Once the projector is turned on, enter the projector’s Signal menu and make sure Computer1 is set to Auto; see page 56.
Connecting Using a BNC-to-VGA Cable

1. Locate a BNC-to-VGA video cable (one may be included with your video equipment).

2. Connect the BNC end of the cable to your player and the VGA end to the **Computer1** port on the projector.

3. If you want to play sound through the projector, see page 27 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see Chapter 2 or the *Quick Setup* sheet for instructions on turning on the projector and adjusting the image.

5. Once the projector is turned on, enter the projector’s Signal menu and make sure Computer1 is set to **Auto**; see page 56.
Connecting to a Computer

You can connect the PowerLite projector to any computer that has a standard video output (monitor) port, including desktop models, PC and Mac notebook computers, and hand-held devices. You can connect up to two computers at the same time to the Computer ports (standard VGA cable connection), see page 25.

After connecting to the computer, you may also want to:

■ connect a monitor to the projector so you can view your presentation close-up as well as on-screen (not necessary if you’re using a notebook); see page 26
■ connect an audio cable to play computer audio; see page 27

**note**

If you connect a Windows-based computer to the projector, you may see a New Hardware Wizard saying your computer has found a plug-and-play monitor; if so, click Cancel.

**note**

If you want to connect an external monitor to the Monitor Out port, your computer must be connected to the Computer1 port.
Connecting to the Computer Port

Follow these instructions:

1. Locate the VGA computer cable provided with the projector.

2. Connect one end to the projector’s Computer port, and the other end to your computer’s monitor port.

3. Optionally, you can connect an external monitor (see page 26), and play sound through the projector (see page 27).

4. When you’ve finished making connections, see Chapter 2 for instructions on turning on the projector and adjusting the image.

5. Once the projector is turned on, enter the projector’s Signal menu and make sure Computer1 is set to Auto; see page 56.

cautions

Don’t try to force a connector to fit a port with a different shape or number of pins. You may damage the port or connector.
Connecting an External Monitor

If you want to monitor your presentation close-up (on a monitor placed beside the projector) as well as on the screen, you can connect an external monitor. You can use it to check on your presentation or switch between picture sources, even if you’ve pressed the A/V Mute button to turn off projection on the screen.

To attach an external monitor, connect it to the projector’s Monitor Out port, as shown:

Follow these guidelines to view images on the monitor:

- The monitor displays the image from the currently selected computer source.
- You can only view images on the monitor while the projector is powered on.
### Playing Sound Through the Projector

You can play sound through the projector’s speaker system, or you can attach an external speaker system. (Attaching speakers to the projector instead of directly to the audio source lets you use the projector’s remote control to adjust the sound.)

### Connecting Audio Equipment to the Projector

To play sound through the projector, follow these steps:

1. Obtain a commercially available stereo mini-jack or RCA-style audio cable. Which cable you use depends on how your equipment is connected:
   - If you have a computer connected to the **Computer1**, **Computer2**, or **S-Video** port, use a stereo mini-jack cable.
   - If you have video equipment connected to the **Video** port, use an RCA-style audio cable.

2. Connect the audio cable to the jack corresponding to the connected video source.

3. Connect the other end of the cable to the audio-output connector on your computer or video equipment.
**Connecting External Speakers**

To connect speakers to the projector, follow these steps:

1. Obtain the appropriate cable to connect your speakers.

   Depending on your stereo system, you may be able to use a commercially available audio cable with a stereo mini-jack connector on one end, and pin jacks on the other end. For some speaker systems, you may have to purchase a special cable or use an adapter to connect to your speakers.

2. Connect the stereo mini-jack end of the audio cable to the **Audio Out** port on the projector.

3. Connect the other end(s) of the cable to your speaker system. You may need to use an adapter to make the connection.

   The projector’s internal speaker system is disabled while sound is output to the external speakers.
Projecting

Once you’ve set up the projector, you’re ready to turn it on, adjust the image, and give your presentation.

Although you can operate the projector without it, the remote control lets you use additional features. See Chapter 3 for instructions on using the remote.

Follow the guidelines in this chapter for:

- Turning the projector on and selecting the image source
- Troubleshooting display problems
- Adjusting the image
- Adjusting the volume
- Shutting down the projector
**Turning On Your Equipment**

Make sure your projector and other equipment are set up as described in Chapter 1. Then follow the instructions below to start the projector and display an image.

Turn on any connected computer or video equipment before starting the projector. This lets the projector automatically detect and display the image source. If you turn on the projector first, or have multiple pieces of connected equipment, you may have to select the image source manually (see page 32).

---

**note**

To shut down the projector, see page 39. Shutting down the projector correctly prevents premature lamp failure and possible damage from overheating.

---

**Turning On the Projector**

Follow these steps to turn on the projector:

1. Plug one end of the power cable into the projector, and the other end into a grounded electrical outlet.

2. Wait until the $\bigcirc$ Power light stops flashing and turns orange.
3. Press the orange \textbf{Power} button on top of the projector—or press the \textbf{Power} button on the remote control.

(If this is your first time using the remote control, make sure the batteries are installed; see page 43.)

The \textbf{Power} light flashes green as the projector warms up, and an image begins to appear. When the \textbf{Power} light stops flashing and remains green (in about 20 seconds) the projector is ready for use.

4. If you've connected a Windows-based computer to the projector, you may see a New Hardware Wizard saying your computer has found a plug-and-play monitor; if so, click \textbf{Cancel}.

\textbf{note}
\textit{If the Direct Power On feature has been enabled, you don't need to press the \textbf{Power} button to turn the projector on. Just plug the projector into an electrical outlet. When the \textbf{Power} light stops flashing and stays on, the projector is ready to use.}

\textbf{warning}
\textit{Never look into the lens when the lamp is on. This can damage your eyes, and is especially dangerous for children.}
Selecting the Image Source

Selecting the image source lets you switch between images input from different pieces of equipment connected to the projector (such as a computer or DVD player).

If you don’t see the image you want, select it using the Source Search button on the projector or the Source buttons on the remote control.

The Source buttons work as follows:

■ Use the Source Search button to switch between equipment connected to the Computer1, Computer2, Video, and S-Video ports.

■ The remote control has four Source buttons. Use them to switch between equipment connected to the port identified on each button.

Note that the Computer1 and Computer2 ports can be set up to use different input signals (for example, Analog RGB or RGB Video)—so if you have equipment connected to one of these ports, it’s important to make sure the correct signal is selected to match the equipment you’re using. You can change the input signal settings using the projector’s menu system; see page 56.
**What To Do If You See a Blank Screen**

If you see a blank screen or a blue screen with the *No Signal* message, try the following:

- Make sure the cables are connected correctly, as described in Chapter 1.

- Make sure the Power light is green and not flashing.

- If you’ve connected more than one computer and/or video source, you may need to press the *Source Search* button on the projector’s control panel or one of the *Source* buttons on remote control to select the correct source. (Allow a few seconds for the image to appear after pressing the button.)

- If you’re using a PC notebook, press the function key on your keyboard that lets you display on an external monitor. It may be labelled CRT/LCD or have an icon such as 📼. You may have to hold down the Fn key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.

**The Projector and Notebook Don’t Display the Same Image**

If you’re projecting from a notebook, and you can’t see your image on the screen and on your computer at the same time, follow these guidelines.

*If you’re using a PC notebook:*

- On most systems, there’s a function key that lets you toggle between the LCD screen and the projector, or display on both at the same time. It may be labelled CRT/LCD or with an icon such as 📼. You may have to hold down the Fn key while pressing it. Allow a few seconds for the image to appear after changing the setting.

- If the function key doesn’t permit you to display simultaneously on both screens, you should check your monitor settings to make sure both the LCD screen and the external monitor port are enabled.
From the Control Panel, open the **Display** utility. In the Display Properties window, click the **Settings** tab, then click **Advanced**. The method for adjusting the settings varies by brand; you may need to click a **Monitor** tab, then make sure the external Monitor port is set as your primary display and/or enabled. See your computer’s documentation or online help for details.

**If you’re using Mac OS X:**

You may need to set up your system to display on the projector screen as well as the LCD screen. Follow these steps:

1. From the Apple menu, select **System Preferences**, then select **Displays**.
2. Make sure the **VGA Display** dialog box is selected.
3. Click the **Arrange** tab.
4. Make sure the **Mirror Displays** checkbox is selected.
Adjusting the Image

Once you see your image, you need to make certain adjustments:

- To focus or zoom your image, see below.
- If the image is too high or too low, you can reposition it. See page 36.
- If the image isn’t square, see page 37.
- If a computer image displays incorrectly, see page 38.

If you need to fine-tune the image and/or sound, see Chapter 4.

Focusing and Zooming Your Image

Open the lens access door, then do the following:

- Use the Focus ring on the projector to sharpen the image.
- Use the Zoom ring on the projector to reduce or enlarge the image. Move the tab toward the W to increase the size, and toward the T to decrease it.

If the image still isn’t large enough, you may need to move the projector farther away from the screen. You can also use the E-Zoom buttons on the remote control to zoom in on a portion of the image. See page 45 for instructions.
Adjusting the Height of Your Image

If the image is too low on the screen, you can use the front adjustable feet to raise it.

1. Lift the front of the projector and turn the front feet to adjust the position of the projected image.

2. If necessary, you can fine-tune the height by turning the projector’s front feet without lifting the front of the projector.

Raising the projector causes the image to become “keystone” shaped, but you can correct the distortion by pressing the ▲ or ▼ buttons on the projector as described in the next section.
**Adjusting the Image Shape**

In most cases, you can maintain a square or rectangular image by placing the projector directly in front of the center of the screen with the base of the lens level with the bottom of the screen.

If the projector is slightly tilted (within a range of 30° up or down), you can use the **Keystone** keys on the projector’s control panel or the projector’s Keystone menu (see “Using Keystone Correction” on page 37) to correct vertical keystone distortion.

If your image is shaped like  or  or , you’ve placed the projector off to one side of the screen at an angle. Place it directly in front of the center of the screen, facing the screen squarely.

**Using Keystone Correction**

To adjust your image when it is wider on the top or bottom, do the following:

- Press the ▲ or ▼ buttons on the projector until you are satisfied with the shape of the image.

---

**note**

The image will be slightly shorter after adjusting.
Or press the Menu button on the remote control, select the Settings menu, and press Enter. From the Settings menu, select Keystone and press Enter. Use the pointer button on the remote control to adjust the keystone setting as needed.

Correcting Computer Images

If you’re connected to a computer and the image doesn’t look right, press the Auto button on the remote control (or the Enter button on the projector’s control panel). This automatically resets the projector’s tracking, sync, resolution, and position settings.

If vertical stripes appear in the projected image and the Auto button doesn’t correct the problem, adjust the projector’s Tracking setting. See page 102 for instructions.

If the image appears fuzzy or flickers and the Auto button doesn’t correct the problem, adjust the projector’s Sync setting. See page 102 for instructions.

Adjusting the Volume

You can use the buttons on the remote control or projector to increase or decrease the volume for the projector’s built-in speaker or an external speaker system connected to the projector. Press the button to increase the volume, or the button to decrease it.

---

**Note**

You must be projecting an image for this button to have any effect. The Auto button works only with computer images. Make sure Auto Setup is turned on to adjust the source automatically; see page 57.

**Note**

You can also adjust the volume using the projector’s menu system. See page 59.
**Shutting Down the Projector**

When you’re finished using the projector, follow the steps below to shut it down. This extends the life of the lamp and protects the projector from possible overheating.

1. Turn off and disconnect any equipment plugged into the projector.

2. To turn off the projector, press the Power button twice.

3. When the Power light is steady orange, you can unplug the projector.

With Epson’s exclusive Instant Off® technology, there’s no cool-down period. When you’re done, just unplug the projector and it’s ready to travel.

**note**

When the projector has not received any input signals for 30 minutes, it automatically turns off the projector lamp and enters “sleep mode.” This conserves electricity, cools the projector, and extends the life of the lamp. If you want to start projecting again, press the Power button. If you are done using the projector, unplug the power cord. To turn off sleep mode, see page 61.

Turn off this product when not in use to prolong the life of the projector.

**caution**

To avoid damaging the projector or lamp, never unplug the power cord when the Power light is green or flashing orange.
Using the Remote Control

The remote control lets you access your projector’s features from anywhere in the room—up to 33 feet away. For example, you can turn the projector on and off, preview and switch between picture sources, turn off picture and sound, freeze the presentation, zoom in on a portion of your image, and access the menu system. (The projector menus let you adjust many projector settings; see Chapter 4).

This chapter covers:

- Using the remote control
- Controlling the picture and sound
- Highlighting your presentation
- Operating two or more projectors with the remote control
Using the Remote Control

Before using the remote, make sure batteries are installed as described on page 43. Then, refer to the tips below:

- Point the remote control either at the front or back of the projector, or at the screen.
- Stand within about 30 feet of the projector.
- Avoid using the remote under bright fluorescent lamps or in direct sunlight, or the projector may not respond properly.

Using the Navigation Buttons

The remote control has various buttons that let you navigate the projector’s help and menu systems; they also let you use the drawing tools to highlight your presentation.

For details on using the buttons to control specific features, see the following sections:

- to navigate the projector’s menu system, see page 52
- to use the projector’s help system, see page 94
- to highlight your presentation, see page 46
**Replacing the Batteries**

The remote control uses two AAA alkaline batteries. Follow these steps when you need to replace them:

1. Press in the tab to remove the battery cover.

2. Remove the old batteries, then insert the new ones as shown.

3. Replace the battery cover. (It should click into place.)

---

**caution**

When replacing batteries, take the following precautions:

- Replace the batteries as soon as they run out. If the batteries leak, wipe away battery fluid with a soft cloth. If fluid gets on your hands, wash immediately.

- Do not expose batteries to heat or flame.

- Dispose of used batteries according to local regulations.

- Remove the batteries if you won’t be using the projector for a long period of time.
**Controlling the Picture and Sound**

You can use the remote control to select your picture sources, temporarily turn off the picture and sound, freeze the action, zoom in on the picture, and adjust the volume.

**Switching Between Picture Sources**

If your projector is connected to more than one computer and/or video source, you can switch between the different sources:

- On the projector’s control panel, there is a **Source Search** button. Press the button to switch between equipment connected to the **Computer1**, **Computer2**, **Video**, and **S-Video** ports.

- On the remote control, there are four **Source** buttons. Use them to switch between equipment connected to the port identified on each button.

After you select a source, the screen goes dark for a moment before the image appears.

**Turning Off the Picture and Sound**

You can use the **A/V Mute** button on the remote control to turn off the image and sound and darken your screen. (If you’ve connected an external monitor to the projector, it will continue displaying.) This feature is useful if you want to temporarily redirect your audience’s attention without the distraction of a bright screen.

- To turn off the picture, press the **A/V Mute** button. The screen goes dark.

- To turn the image back on, press the button again.

You can also have an image, such as a company logo, display on the screen whenever you press the **A/V Mute** button (see page 60).
**Stopping Action**

You can use the remote control to stop the action in your video or computer image.

- Press the Freeze button to stop the action and keep the current image on the screen. The sound continues.
- Press the Freeze button again to restart it.

**Zooming Your Image**

You can zoom in on a portion of the image using the E-Zoom buttons on the remote control.

1. Press the E-Zoom button on the remote control.
   - You see a cross-hair indicating the center of the zoom-in area.
2. Use the pointer button to position the cross-hair.
3. Continue pressing the E-Zoom button to enlarge the selected area up to 4×.
4. While the image is enlarged, you can:
   - Use the pointer button to pan about.
   - Press the E-Zoom button to zoom out.
5. When done, press the Esc button to return to the original size.

---

**note**

This function pauses the image, but not the sound. Also, because the source continues to transmit signals, you won’t resume the action from the point you paused it.
**Changing the Image’s Aspect Ratio**

If you’re projecting a widescreen format image, you can use the **Aspect** button on the remote control to change the aspect (width to height) ratio from 4:3.

You can change video images to 16:9 (widescreen format), or 16:9 (Up) or 16:9 (Down) (to accommodate subtitles or supertitles).

You can change computer images to 16:9 (widescreen format) or Normal.

Press the **Aspect** button again to cycle through the available options.

You can also change the aspect ratio using the projector’s Signal menu. See page 56 for details.

**Highlighting Your Presentation**

You can display a pointer to call out something on the screen or emphasize particular points. There are three pointer shapes you can choose from.

**Using the Pointer Tool**

1. To activate the pointer tool, press the **Pointer** button on the remote control. A pointer appears on the screen.

   ![Pointer Image]

   If you prefer to use a different pointer, see page 47 for instructions on changing the pointer shape.

2. Use the □ pointer button on the remote control to position the pointer on the screen.

3. When you’re done using the pointer, press the **Pointer** or **Esc** button on the remote control.
**Changing the Pointer Shape**

Follow the steps below to change the pointer shape.

1. Press the **Menu** button on the remote control, highlight the **Settings** menu, and press Enter.

   You see this screen:

   ![Remote Control Settings Menu]

   2. Highlight **Pointer Shape** and press Enter.

   3. Select the pointer you would like to use, then press Enter to select it.

   4. When you have finished selecting a pointer shape, press the **Menu** button to exit the menu system.

**Operating Two or More Projectors with the Remote Control**

If you’re using more than one projector, you can control all the projectors—or just selected ones—by using the projector ID system. To operate a projector, you have to set the remote control’s ID to match that of the projector. Or you can control all the projectors at once by setting the remote control’s ID to zero.
**Setting the Projector ID**

The projector’s default ID is set to Off. This lets it respond to commands from any remote control. To change the ID, follow these steps:

1. Press the **Menu** button on the remote control. You see the projector’s menu screen.
2. Select **Extended > Projector ID**.
3. Use the ☰ pointer button to highlight the new ID, and press **Enter** to select it.
4. When done, press **Menu** to exit the menu system.

**Setting the Remote Control ID**

The remote control’s default ID is zero. This lets you operate any projector. To set it to operate a specific projector, follow these steps:

1. Point the remote control at the projector you want to be able to operate.
2. Press and hold the **ID** button on the remote control.

**note**

*If you’re using a remote control ID other than the default ID of zero, you have to set the ID each time you turn on the projector.*
3. While holding the ID button, press a numbered button on the remote control (0 through 9) to select the desired ID. Select zero to control all projectors, or select a number to match the ID of the projector(s) you want to operate.

After setting the ID, you can check whether the remote control works with a specific projector:

1. Point the remote control at the projector you want to check.
2. Press the ID button on the remote control. You see a message on the screen like one of these:

   ![Projector ID: On](image1)
   ![Projector ID: Off](image2)

If the message says the remote control is “On,” then you can use the remote control to operate that projector. If it says “Off,” then you have to change the ID of the remote control and/or projector before operation is possible.
Configuring the Projector

You can use the projector’s on-screen menus to adjust the image, sound, and other features. This chapter covers the following information:

- Using the menu system
- Adjusting color and clarity
- Adjusting the input signal
- Customizing projector features
- Selecting projector setup options
- Selecting network settings
- Viewing lamp usage and other information
- Using the projector’s security features
Using the Menu System

You can use the remote control (or the projector’s control panel) to access the menu system and change settings. Follow these steps:

1. To display the menu screen, press the Menu button.

You see a menu screen similar to the one shown below (the settings may differ from those shown here, depending on the selected input source):

![Menu Screen](image)

The menus are listed on the left, and the options available for the highlighted menu are shown on the right.

2. Use the pointer button on the remote control (or the arrow buttons on the projector) to scroll through the menu list. When you’ve highlighted the desired menu, press the Enter button to select it.

3. Once you’ve selected the menu, use the pointer button to scroll through the list of options. (Some of the options may be grayed out or unavailable, depending on the selected source.)
4. After highlighting the option you want to adjust, use the pointer button to change the setting. In some cases, you may have to press the Enter button to see a sub-screen for changing the setting.

- Press the left or right side of the pointer button to adjust a slider bar.
- To select from two or more settings, use the pointer button to highlight the desired setting, then press Enter.

5. After changing the settings, press the Esc button to save your changes and return to the previous menu (or press it repeatedly to exit the menu system).

You can also press the Menu button to exit the menu system.

**Restoring the Default Settings**

You can use the menu system’s Reset options to restore the factory-default settings for:

- all the settings listed in a specific menu
- all the settings in all menus

To restore the settings in a specific menu, enter the menu whose settings you want to change, select Reset, and confirm as needed. (The example below shows how to reset the Image menu.)

![Image menu screenshot]

To restore all the projector settings to their factory-default values, select the Reset menu, then select Reset All.

**note**

Reset All *does not reset the Computer Inputs, User’s Logo, Language, Screen ID, Network, or Lamp settings. To reset the User’s logo and Language settings, use the Reset option on the Extended menu.*
Adjuming Colors and Clarity

The Image menu lets you make adjustments to the colors of the projected image and fine-tune brightness, contrast, and sharpness. The options available depend on which image source is selected.

1. Press the Menu button on the remote control, then press the Enter button to select the Image menu.

You see the Image menu screen. (The actual settings may vary, depending on the selected input source. The Image menu below is for a component video, composite video, or S-Video source.)

2. Use the pointer button to highlight menu items, then press the Enter button to select from any of the following options:

   - **Color Mode**
     Corrects the vividness of image color. You can select from the following six settings:

       - **Text**: For black-and-white presentations in a bright room.
       - **Photo**: For displaying still photos in vivid color and high contrast in a bright room.
       - **Sports**: For watching TV in a bright room.
       - **Presentation**: For presentations in a bright room.
       - **Theatre**: For optimizing movie images with natural color in a dark room.
       - **Game**: For playing video games in a bright room.
sRGB: For projecting standard sRGB computer displays.

Blackboard: Fixed color mode for projecting against a green blackboard.

- **Brightness**
  Lightens or darkens the overall image.

- **Contrast**
  Adjusts the difference between light and dark areas.

- **Color Saturation**
  Adjusts the depth or intensity of the image colors.

- **Tint**
  Adjusts the tint of the image (not available for RGB video images).

- **Sharpness**
  Adjusts the sharpness of the image.

- **Color Adjustment**
  Adjusts the temperature and intensity of red, green, and blue.

3. When the image is set correctly, press Esc or Menu. Your settings are automatically saved.

---

**note**

*The Brightness setting changes the opacity of the projector’s LCD panels. You can also adjust the brightness of the lamp itself. Select Brightness Control in the Settings menu, then choose High or Low (the default setting is High). Selecting the low brightness setting extends the life of the lamp (see page 114).*
**Adjusting the Input Signal**

1. Press the **Menu** button on the remote control, highlight **Signal**, then press the **Enter** button to select the Signal menu.

You see one of the following screens:

- **Computer (analog RGB) and RGB video**
- **Component video**
- **Composite video and S-Video**
2. Use the pointer button to highlight menu items, then press the Enter button to select from any of the following options:

- **Auto Setup** (computer images)
  Leave this setting On to automatically optimize the computer image when you switch to a computer source. Turn it Off if you want to save adjustments you have made to the video settings below.

- **Tracking** (computer images)
  Removes unwanted vertical lines from a computer image by matching the projector’s internal clock to various computer signals. See page 102 for more information about adjusting the tracking setting.

- **Sync.** (computer images)
  Corrects fuzziness or screen flicker by synchronizing the projector with the tracking signal sent from the computer. See page 102 for more information about adjusting the sync. setting.

- **Position**
  Use the pointer button to move the image on the screen left, right, up, or down.

- **Progressive**
  Leave this setting On when viewing S-Video or composite video so that interlaced-to-progressive conversion is carried out (best for fast-moving pictures). If you notice flickering while viewing still images, switch this setting to Off.

- **Computer1 Input**
  Selects the signal from equipment connected to the Computer1 port. If your image colors look wrong, try changing this setting to Auto, or to Component Video for component video sources.

- **Computer2 Input**
  Selects the signal from equipment connected to the Computer2 port. If your image colors look wrong, try changing this setting from Auto to RGB for computer or RGB video sources, or to Component Video for component video sources.

---

**note**
You can also use the remote control’s Auto button to automatically reset the projector’s tracking, sync, and position settings.
- **Video Signal** (composite and S-Video)
  Leave this setting at **Auto** unless you are using a 60-Hz PAL system (select PAL60).

- **Aspect** (video)
  Sets the image’s aspect ratio (ratio of width to height). Select 4:3 for normal computer content, 4:3 for letterbox video content, 16:9 for widescreen video content, or 16:9 (Up) or 16:9 (Down) for video content with subtitles or super titles.

3. When you’re finished, press **Esc** or **Menu**.

---

**Customizing Projector Features**

The Settings menu lets you customize the way you use the projector, from adjusting lamp brightness and speaker volume to changing the shape of the pointer.

1. Press the **Menu** button on the remote control, highlight **Settings**, then press the **Enter** button to select the Settings menu.

   ![Settings Menu]

2. Use the ⬇️ pointer button to highlight menu items, then press the **Enter** button to select from any of the following options:

   - **Keystone**
     Adjusts a distorted image from a trapezoid shape to rectangular when the projector is tilted up or down.
■ **Operation Lock**
In **Full Lock** mode, disables all of the projector’s buttons, including the Power button. In **Partial Lock** mode, disables all of the projector’s buttons except the Power button. Changes to this setting take effect after you restart the projector. (After you turn off the projector, wait for the Power light to turn solid orange before turning it on again.)

■ **Pointer Shape**
Lets you select from three different pointer shapes. The Password Protect function must be cancelled first. See page 70.

■ **Brightness Control**
Allows you to select Low lamp brightness when the projection is too bright for the room. The Low setting also reduces electricity consumption and fan noise. Select High to project at the maximum brightness. (Also check the Brightness setting in the Image menu; see page 55.)

■ **Volume**
Adjusts the volume for the projector’s speaker or an audio system connected to the projector.

■ **RCA Audio Input**
Lets you change the L-Audio-R audio port as the input for the Video port or S-Video port. Select Video to use the RCA port for the Video port. Select S-Video to use the RCA port for the S-Video port.

■ **Remote Receiver**
Select Off to disable the remote control receivers on the projector to prevent interference from fluorescent lighting or other sources. Or enable specific receivers using the following settings: Front/Rear, Front, or Rear.

■ **Test Pattern**
Allows you to adjust the projector without a video source. While the test pattern is displayed, you can make Zoom, Focus, and Keystone adjustments.

3. When you’re finished, press Esc or Menu.
Selecting Projector Setup Options

Use the Extended menu to customize the way you set up the projector. You can configure the projector for rear and/or ceiling projection, change the language for the menus and messages, set the screen background color, capture and store a custom image or logo for the startup screen, and set up the projector for network use.

1. Press the Menu button on the remote control, highlight Extended, then press the Enter button to select the Settings menu.

2. Use the pointer button to highlight menu items, then press the Enter button to select from any of the following options:

- **Display**
  - **Messages**: Lets you turn screen messages On and Off.
  - **Display Background**: Sets the screen background to Black, Blue, or Logo when the projector isn’t receiving a video signal.
  - **Startup Screen**: Enables or disables display of the startup screen when the projector is turned on.
  - **A/V Mute**: Sets the screen background to Black, Blue, or Logo when the A/V Mute button is pressed.
  - **Closed Caption**: Lets you select from the following closed caption settings: Off, CC1, CC2, CC3, CC4, TEXT1, TEXT2, TEXT3, or TEXT4.

**note**
The Startup Screen option cannot be turned off if the User’s Logo Protect feature has been turned on. See page 70.
■ **User’s Logo**
Turn this setting **On** to display the image or logo you have captured whenever the projector is turned on. See page page 66 for more information.

■ **Projection**

**Front:** Projector is in front of the screen.

**Front/Ceiling:** Projector is in front of the screen, mounted upside-down from the ceiling.

**Rear:** Projector is behind the screen.

**Rear/Ceiling:** Projector is behind the screen, mounted upside-down from the ceiling.

■ **Operation**

**Direct Power On:** When this feature is enabled, projection starts as soon as you plug in the power cord. You don’t have to press the ☐ **Power** button.

**Sleep Mode:** When this feature is enabled, the projector’s lamp automatically turns off when the projector has not received any input signals for more than 30 minutes. This conserves electricity, cools the projector, and extends the life of the lamp. To resume projecting, press the ☐ **Power** button.

**Sleep Mode Timer:** When the Sleep Mode setting is enabled, you can set the period of time before the projector turns off automatically, from 1 to 30 minutes.

**High Altitude Mode:** Turn this setting **On** when using the projector above an altitude of 4,921 feet (1,500 meters). This setting ensures that the internal temperature of the projector is regulated properly. Turn this setting off for lower elevations.

■ **Standby Mode**
Select **Network On** to use the network monitoring and control functions while the projector is in standby mode (the ☐ **Power** light is orange).

---

**note**

*When Direct Power On is enabled, press the ☐ **Power** button to turn the projector off, wait until the ☐ **Power** light remains solid orange, then unplug the projector.*
■ Air Filter Setting

Alarm Timer: Lets you turn the air filter replacement notification on or off. If you are using the smoke air filter, make sure this setting is turned On.

Timer: Lets you change the amount of time the projector waits before displaying the air filter replacement notification.

Clean Notice: When this setting is enabled, the projector displays a message when the air filter is clogged with dirt or dust.

Clean Notice Timing: Lets you select from five intervals at which the cleaning notice is displayed. If the projector is being used in a dusty environment, set this setting to Level 1 (Early).

■ Projector ID

Lets you assign a numeric ID to each projector. When you are using multiple projectors, you can use the ID to select the one you want to operate with the remote control. See page 47 for instructions.

■ Multi-screen

Screen ID: Lets you set individual IDs for multiple projectors when performing Image Correction adjustments. This allows you to use one remote control for all of the projectors. To select a projector, press and hold the Num button on the remote control while pressing the number button that corresponds to the projector’s Screen ID.

Image Correction

Adjustment Level: Select each Adjustment Level (1 to 5) one at a time and adjust the Brightness Correct and Color Correct settings until the projected images match on all of the projectors.

Brightness Correct: Lets you adjust the difference in brightness for each projector.

Color Correct: Lets you adjust the difference in color for each projector.
■ Language
  Lets you select the language to be used for the projector menus.

3. When you’re finished, press Esc or Menu.

**Selecting Network Settings**

For information connecting the projector to a network and monitoring the projector over a network, see “Monitoring the Projector Over a Network” on page 73.
Configuring the Projector

Viewing Lamp Usage and Other Information

Use the Info menu to view information about the display settings of your computer and video devices and the number of hours the lamp and filter have been used.

1. Press the Menu button on the remote control and highlight Info.

You see one of the following menus:

![Menu options for different inputs](image)

- **Lamp Hours**
  - Displays the number of hours the lamp has been used. The life span of the lamp is about 4000 hours in High or Low brightness mode. If the number shown is close to 4000 or the information is displayed in red, make sure you have a spare lamp handy.

**note**
The lamp usage timer doesn’t register until you’ve used the lamp for at least 10 hours.

- **Lamp Hours**
  - Displays the number of hours the lamp has been used. The life span of the lamp is about 4000 hours in High or Low brightness mode. If the number shown is close to 4000 or the information is displayed in red, make sure you have a spare lamp handy.
- **Air Filter**
  Displays type of air filter and the number of hours it has been used.

- **Source**
  Displays the input source currently being used.

- **Input Signal** (computer, RGB video, and component video)
  Displays the input signal currently being used.

- **Resolution** (computer, RGB video, and component video)
  Displays the input resolution currently being used.

- **Refresh Rate** (computer, RGB video, and component video)
  Displays the refresh rate.

- **Sync Info** (computer, RGB video, and component video)
  Displays information that may be needed by a service technician.

- **Video Signal** (composite and S-Video)
  Displays the video signal format currently being used.

- **Status**
  Displays information about errors that have occurred in the projector. This information may be needed by a service technician.

---

**Using the Projector’s Security Features**

To prevent unauthorized use of the projector, you can do the following:

- Create an identifying user logo that is displayed at startup and/or when the A/V Mute button is pressed

- Assign a password that’s required to be entered every time the projector is turned on; this can be disabled for a set period of time if you want to loan the projector to someone

- Disable the projector’s buttons; this is useful, for example, if you’re projecting in a classroom and you want to ensure that no one touches the projector’s buttons while you’re using the remote control

---

**note**

The air filter usage timer doesn’t register until you’ve used the filter for at least 10 hours.
If you assign the projector a password, a screen appears requesting the password whenever the projector is turned on. If you enter the password incorrectly three times in succession, the projector’s operation is locked and you’ll need to disconnect the power cord, then reconnect it to redisplay the password screen. If an incorrect password is entered 30 times in a row, the projector is locked and you’ll need to contact Epson to unlock it. See “Where To Get Help” on page 106.

If someone else will be using the projector for awhile but you want to make sure the person returns it by a certain time, you can temporarily disable the password for a set period of time. When that time has elapsed, the password is reactivated and must be entered before the projector can be used.

When you enable the Operation Lock feature, all of the projector’s buttons are disabled except the Power button.

Creating Your Own Screen Logo

You can transfer any image on your computer to the projector, and then use it as the startup screen and/or the screen that is displayed when you press the A/V Mute button. The image can be a company logo, slogan, photograph, or any other image you want to use. The projector considers this image the User’s Logo.

If you create a user’s logo for the projector, you can lock the logo on so it is displayed as the startup screen and/or A/V Mute screen. Unauthorized users cannot turn it off or change it. This feature is intended to discourage theft and provides a way to identify the projector should it be stolen.

Follow the steps below to capture the image and transfer it to the projector:

1. Display the image you want to use on the projector. You can use an image from either a computer or video source, such as a VCR.
2. Press the Menu button on the remote control, highlight Extended, then press the Enter button.
3. Use the pointer button to highlight User’s Logo, then press the Enter button.

4. When you see the message Choose this image as the User’s Logo?, select Yes and press Enter. A selection box displays over the image.

5. Use the pointer button on the remote control to select the area of the image you want to use. Once you have selected the area, press Enter.

6. When you see the message Select this image?, choose Yes and press Enter.

   If you want to change the area selected, select No, press Enter and repeat steps 4 through 6.

**note**
If the User’s Logo Protect function is enabled, you see a message that the logo cannot be recorded. You’ll need to disable the User’s Logo Protect function before you can create or change the User’s Logo. See page 70.
The text explains the steps to configure the projector. It includes:

7. When you see this screen, select a zoom rate (display size), and press Enter.

8. When you see the message **Save this image as the User’s Logo?**, select **Yes** and press Enter. Saving the logo takes a few moments. Do not use the projector or other sources (computer, video, etc.) while the logo is being saved.

9. When you see the message **Completed**, press Esc.

### Displaying Your Screen Logo

Follow the steps below to display your logo when there is no signal, when the projector is turned on, and when the A/V Mute button is pressed:

1. Press the **Menu** button on the remote control, select the **Display** menu, and press Enter.

2. To display your logo when the projector is not receiving a video signal, select **Display Background** and press Enter.

3. Select **Logo** and press Enter.

4. Press the **Esc** button on the remote control to return to the Display menu.

5. To display your logo when the projector is turned on, select **Startup Screen** and press Enter.

6. Select **On**, then press the **Enter** button.

7. Press the **Esc** button on the remote control to return to the Display menu.
8. To display your screen logo when the A/V Mute button is pressed, select A/V Mute and press Enter.


10. When you’re finished, press the Menu button on the remote control to exit the menu system.

**Setting a Password**

Follow the steps below to set a password for the projector.

1. Press and hold down the Freeze button on the remote control until you see the Password Protect menu:

   ![Password Protect Menu]

2. Select Password and press Enter.

3. When you see the Change the password? message, select Yes and press Enter.

4. Press and hold down the Num key on the remote control while you use the numeric keypad to enter a 4-digit password.

   The password will be displayed as ****. After you enter the last digit, a confirmation screen appears. Enter the password again.

5. After you are finished setting the password, press the Menu button to exit to the Password Protect menu.

Make a note of the password and keep it in a safe place in case you forget it.

---

**note**

If a password has already been set, you’re prompted for a password when entering the Password Protect menu. To enter the password, see “Starting the Projector with a Password” on page 72.
Protecting Projector Settings

You can password protect the User’s Logo and Network settings to prevent them from being changed. Make sure you’ve set a password for the projector as described on page 69, then follow the steps below:

1. Press and hold down the Freeze button until you see the Password Protect menu.

2. To protect your logo from being changed or disabled, select User’s Logo Protect and press Enter.


4. To protect your network settings from being changed, select Network Protect and press Enter.

5. Select On and press Enter.

6. Press Menu to exit the Password Protect menu.

If you lose the remote control, you will not be able to enter the password, so keep the remote control in a safe place at all times.

note

If you enter the password incorrectly three times in succession, the projector’s operation is locked and you’ll need to turn it off and disconnect the power cord, then reconnect it. If an incorrect password is entered 30 times in succession, the projector is locked and you’ll need to contact Epson to unlock it. See “Where To Get Help” on page 106.
**Turning On Password Protection**

If you enable the Power On Protect setting, a screen appears requesting the password whenever the projector is turned on. Make sure that you’ve set a password for the projector as described on page 69. Then follow the steps below:

1. Press and hold down the **Freeze** button until you see the Password Protect menu:

   ![Password Protect Menu]

2. Select **Power On Protect** and press **Enter**. Then select **On** and press **Enter**.

3. Press **Menu** to exit the Password Protect menu.

   If you lose the remote control, you will not be able to enter the password, so keep the remote control in a safe place at all times.

   **note**

   If you are prompted for a password, press and hold down the **Num** key on the remote control while you use the numeric keypad to enter the password.

   If you enter the password incorrectly three times in succession, the projector’s operation is locked and you’ll need to turn it off and disconnect the power cord, then reconnect it. If an incorrect password is entered 30 times in succession, the projector is locked and you’ll need to contact Epson to unlock it. See “Where To Get Help” on page 106.
Starting the Projector with a Password

When the password function is enabled, you see a password entry screen when you turn on the projector.

Press down the Num button on the remote control as you use the numeric keypad buttons to enter the password. Once you have entered the password correctly, the password screen closes, and projection begins.

If the password is not correct, you see the message **Wrong password. Please try again.** If you enter an incorrect password three times in succession, you see the message **The projector’s operation will be locked. Request code xxxxx** and the projector switches to standby mode for approximately 5 minutes. Write down the request code. Then disconnect the projector’s power cord from the electrical outlet, reconnect it, and turn the projector back on.

When you see the password prompt again, you can try to re-enter the correct password.

If you have forgotten the password, contact Epson with the request code number that appears in the Password Protect Release screen for assistance. See “Where To Get Help” on page 106.

If you enter an incorrect password 30 times in succession, the projector remains locked and you must contact Epson to unlock it.

Disabling the Projector’s Buttons

When you enable the Operation Lock function, all of the projector’s buttons are disabled except for the **Power** button.

1. Press the **Menu** button on the remote control, highlight **Settings**, then press the **Enter** button.
2. Select **Operation Lock** and press **Enter**.
3. Select **Full Lock** to lock all of the buttons on the control panel or **Partial Lock** to lock all of the buttons on the control panel except for the **Power** button, then press **Enter**.
4. Select **Yes** and press **Enter** to confirm the setting.
5. Press the **Menu** button to exit the menu system.

**note**

*To cancel the Operation Lock, press the projector’s **Enter** button on the projector for seven seconds.*
Monitoring the Projector Over a Network

The software included with your projector lets you control your projector(s) over a network.

■ Use EMP Monitor (available for Windows only) to see your projectors’ status, switch image sources, and control basic settings.

■ Use the e-mail notification function to receive alerts about possible problems.

■ Use a network management utility running SNMP to manage your facility’s equipment from a pre-existing system.

To use the software to manage your projectors, first install EMP Monitor. Then connect and configure each projector you want to monitor as described here.

This chapter covers the following information:

■ Installing the network software

■ Connecting the projector a network

■ Selecting network settings

■ Monitoring and controlling the projector with EMP Monitor

■ Using e-mail alerts

■ Using a browser to monitor the projector

■ Understanding the notifications messages
Installing the Network Software

The projector software CD-ROM includes EMP Monitor for monitoring your projector from a remote location.

System Requirements

Before you install the software, make sure your computer meets these requirements:

- Microsoft® Windows 98SE, Me, 2000 (SP4), XP, or Windows Vista™ 32-bit
- IBM® compatible PC with at least a Pentium® III 1.2 GHz processor
- At least 256MB of RAM (512MB recommended)
- At least 128MB of free hard disk space
- XGA (1024 × 768) or better display adapter and monitor, 16-bit color or higher

Installing the Software

1. Insert the projector software CD-ROM in your computer’s CD-ROM or DVD drive.
2. Follow the on-screen instructions to install the software.
   
   Once installed, you can access EMP Monitor from your computer’s Start menu.
Connecting to the Network

Follow these steps to connect the projector to your network and configure it with an IP address.

1. Connect the projector to your network using a commercially available 100BaseTX or 10BaseT Ethernet network cable. Connect the cable to the LAN port on the projector.

2. Press the projector’s Power button to turn it on.
Selecting Network Settings

Follow the instructions in this section to set up the projector’s network settings in the menu system.

1. Press the Menu button.
2. Select the Network menu.

3. Press Enter. Then use the pointer button to highlight menu items and the Enter button to set the following options:

- **Wired LAN**
  
  If your network assigns addresses automatically, turn on the DHCP setting.

  If your network does not assign addresses automatically, turn off DHCP and enter the projector’s IP Address, Subnet Mask, and Gateway Address as needed.

  To enter numbers, use the numeric buttons on the remote control.

- **PJLink Password**
  
  Lets you enter a password for using the PJLink™ protocol to control the projector.

- **Web Control Password**
  
  Lets you enter a password for accessing the projector over the web from a computer running the EMP Monitor software.
SNMP

If you’re a network administrator, you can use the SNMP option to enter a Trap IP Address. This lets you receive trap alerts for the projector on a computer running the SNMP Manager software.

Mail

When enabled, the projector sends you an e-mail alert if it has any problems. For instructions on setting up e-mail alerts, see the next section.

AMX Device Discovery

Allows the projector to be detected when it’s connected to an AMX™ controller or a network that supports AMX Device Discovery.

Projector Name

Displays the name for identifying the projector over the network.

Using Projector E-mail Alerts

When this feature is enabled, the projector sends you an e-mail alert if it has any problems.

1. Press the Menu button, select the Network menu, and press Enter.

2. Select Mail and press Enter.

3. Select the following settings as necessary:

   Mail Notification
   Select On to enable sending of an e-mail if there is a problem with the projector.

   SMTP Server
   Enter the IP address of your SMTP server. You can enter a number from 0 to 255 in each field of the address.

   Port Number
   Displays the SMTP port number.

note

If you’re a network administrator, you can use the SNMP option to enter a trap IP address. This lets you receive trap alerts for the projectors you’re monitoring.

note

You can also set e-mail alerts from EMP Monitor (see page 82).
Monitoring the Projector Over a Network

■ Address 1/2/3 Setting
Choose one of the Address Setting fields, then enter the e-mail address where you want to receive a message when a problem occurs.

4. When you’re done, press Menu to exit the menu system.

When a problem occurs, an e-mail message is sent to the specified addresses with the subject line EPSON Projector and the following information:

■ Line 1: The name of the projector where the problem has occurred
■ Line 2: The IP address of the projector where the problem has occurred
■ Line 3: Details of the problem

Using EMP Monitor

EMP Monitor lets you use a remote computer to manage your projectors. It lets you easily turn them on or off (together or individually), switch image sources, and check on their status.

Before using EMP Monitor, make sure you’ve installed the software (available for Windows only) as described on page 74. The computer you’re using to monitor the projector should already be connected to your network.

Opening and Closing EMP Monitor

To start EMP Monitor, click Start > Programs or All Programs > EPSON Projector > EMP Monitor.
If you’ve added the program to the Startup programs folder, it may already be open. If so, click the icon in the system tray on the lower-right corner of your screen to display the EMP Monitor window:

To close EMP Monitor, select Exit from the File menu or right-click the program icon shown above, then select Exit.

**Registering a Projector**

Before you can monitor a projector, you have to register it. Follow these steps to automatically search for your projector(s).

1. Open EMP Monitor.
2. Select Edit > New > Projector (automatic search).
3. Click Search to locate projectors currently operating on the network.
4. Select the projector you want to add by clicking its name, then click the Edit button.
5. Enter a Display name, select a Parent group, if necessary, enter a Monitor Password, if necessary, and a Description for the projector.
6. Click the Register button.
7. To register additional projectors with EMP Monitor, repeat steps 2 through 6.
8. When you’re done adding projectors, click Cancel. You see a screen with a list of all registered projectors.

*note*

If the projector is not automatically found, your projector may not be connected or configured correctly for the network. See page 75.

To delete a projector from the list, right-click the projector name, and click Delete.
**Monitoring Your Projectors**

The EMP Monitor screen lets you monitor your projector(s) status and check if a problem has occurred.

For the most current status, click the **Refresh** button.

The following table describes the EMP Monitor status icons:

<table>
<thead>
<tr>
<th>Group status icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>No warnings or problems. All projectors in the group are operating normally.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Warning or problem. A projector in the group has a warning or problem.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Notification. A projector in the group requires immediate attention.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Monitoring disabled. Right-click the icon and select <strong>Monitoring Enabled</strong> to begin monitoring the group.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Data is currently being updated.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type status icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>No warnings or problems.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Warning or problem.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Notification.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Monitor Password error. No monitor password was entered when the projector was registered, or an incorrect password was entered.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Monitoring disabled. Right-click the icon and select <strong>Monitoring Enabled</strong> to begin monitoring the projector.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Data is currently being updated.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Network error (for example, the projector is not connected to the network, or power cable is disconnected). You may also see this error if <strong>Network Off</strong> is selected in Standby Mode (see page 61).</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Network error (Esc/VP.net communication error).</td>
</tr>
</tbody>
</table>

**note**

To monitor a projector when it’s in standby mode (plugged in but not turned on), you must select **Network On** as the **Standby Mode** setting in the projector’s menu system (see page 61).

For detailed status information, right-click the projector and click **Property**.

**note**

To create projector groups in EMP Monitor, refer to the on-screen Operation Guide.
### Power status icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green Light]</td>
<td>The projector is powered on and its status is normal.</td>
</tr>
<tr>
<td>![Grey Light]</td>
<td>The projector is powered off and its status is normal.</td>
</tr>
<tr>
<td>![Green Light with Exclamation]</td>
<td>The projector is powered on and its status is abnormal.</td>
</tr>
<tr>
<td>![Grey Light with Exclamation]</td>
<td>The projector is powered off and its status is abnormal.</td>
</tr>
</tbody>
</table>

### Temperature level status icons

<table>
<thead>
<tr>
<th>Icons</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>![One Blue Bar]</td>
<td>The projector’s internal temperature is normal (low).</td>
</tr>
<tr>
<td>![Two Green Bars]</td>
<td>The projector’s internal temperature is normal (medium).</td>
</tr>
<tr>
<td>![Three Yellow Bars]</td>
<td>The projector’s internal temperature is normal (high).</td>
</tr>
<tr>
<td>![Four Red Bars]</td>
<td>The projector’s internal temperature is high (high-temperature warning).</td>
</tr>
<tr>
<td>![Six Red Bars]</td>
<td>The projector’s internal temperature is too high (internal temperature error). The projector is turned off automatically.</td>
</tr>
</tbody>
</table>

### Error status icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Air Filter Icon]</td>
<td>Clean air filter notice. The air filter needs to be cleaned; see page 87.</td>
</tr>
<tr>
<td>![Lamp Icon]</td>
<td>Lamp life warning. The lamp is nearing the end of its life; see page 89.</td>
</tr>
<tr>
<td>![High Temperature Icon]</td>
<td>High-temperature warning. The projector is getting too hot but continues to operate.</td>
</tr>
<tr>
<td>![Replace Air Filter Icon]</td>
<td>Replace air filter; see page 87.</td>
</tr>
<tr>
<td>![No Air Filter Icon]</td>
<td>No air filter. The air filter is not installed or installed incorrectly; see page 87.</td>
</tr>
<tr>
<td>![Low Air Flow Icon]</td>
<td>Low air flow. The air filter needs to be cleaned or replaced; see page 87.</td>
</tr>
<tr>
<td>![Air Flow Sensor Error Icon]</td>
<td>Air flow sensor error. There is a problem with the projector’s air flow sensor; contact Epson as described on page 106.</td>
</tr>
</tbody>
</table>
You can set up e-mail alerts to warn you of problems with the projector.

1. Open EMP Monitor.
2. From the Tool menu, select **Mail notification function**.
3. Turn the Mail notification function setting **On**.
4. Enter the IP address and port number of your network’s SMTP (outgoing) mail server.
5. Enter the Sender (projector) mail address.
6. Enter up to three e-mail addresses to send alerts to in the Recipient mail address boxes.
7. Click the **Notification event** buttons to select the conditions under which an e-mail alert will be sent.

### Using E-mail Alerts

**note**

You can also set e-mail alerts from the projector’s menu system (see page 77).

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low air flow error</td>
<td>The air filter needs to be cleaned or replaced; see page 87.</td>
</tr>
<tr>
<td>Air filter air flow sensor error</td>
<td>Contact Epson as described on page 106.</td>
</tr>
<tr>
<td>Lamp cover door open</td>
<td>Close the lamp cover door; see page 89.</td>
</tr>
<tr>
<td>Lamp error</td>
<td>The lamp may need to be replaced; see page 89.</td>
</tr>
<tr>
<td>Lamp failure at power on</td>
<td>The lamp has reached its end of life or is installed incorrectly; see page 89.</td>
</tr>
<tr>
<td>High internal temperature error</td>
<td>The projector is turned off automatically.</td>
</tr>
<tr>
<td>Internal (system) error</td>
<td>Contact Epson as described on page 106.</td>
</tr>
<tr>
<td>Fan error</td>
<td>Contact Epson as described on page 106.</td>
</tr>
<tr>
<td>Sensor error</td>
<td>Contact Epson as described on page 106.</td>
</tr>
<tr>
<td>Other error</td>
<td>Contact Epson as described on page 106.</td>
</tr>
</tbody>
</table>
8. When you’re done, click the OK button.

If a projector experiences a problem, EMP Monitor sends an e-mail message to each of the addresses you entered in the Set mail notification function window. The subject line and body of the message includes the projector’s name and the warning or error (similar to those listed on page 80).

When the problem has been fixed, EMP Monitor sends a message indicating the problem has been resolved.

**Using a Browser to Monitor the Projector**

If your projector is connected to a network, you can use a standard web browser to monitor and control it. When using a browser to access the projector, you cannot connect through a proxy server.

1. Make sure that the projector is connected to your network, as described on page 75.

2. Follow the instructions on page 61 to set **Standby Mode** to **Network On** in the Extended menu so you can monitor the projector in standby mode.

3. Open your web browser and enter the IP address of the projector you want to monitor in the browser window.

   If you’re not sure what the address of the projector is, turn the projector on and select **Wired Lan** from the Network menu to display the IP address of the projector. See page 76.

   You see a login screen.

4. Do one of the following:
   - If you didn’t set a Web control password in the Network menu, click OK.
   - If you set a Web control password in the Network menu, enter it in the Password box, then click OK.

   You see a screen displaying the settings you can change.
5. Select one of the menu options, then change any of the settings as needed. These settings correspond to those found in the projector’s menu system. See page 51 for details.

You cannot change the following settings using a web browser:

- **Pointer** and **Test Pattern** in the Settings menu
- **Closed Caption**, **High Altitude**, **User’s Logo**, or **Language** in the Extended menu
- **Reset All**, **Reset Air Filter Time**, or **Reset Lamp Hours** in the Reset menu

6. Use the controls at the bottom of the screen to choose a source, stop the action, turn off the picture and sound, or turn the projector’s power on or off.
warning
Before you clean any part of the projector, turn it off and unplug the power cord. Never open any cover on the projector, except the lamp and filter covers. Dangerous electrical voltages in the projector can injure you severely. Do not try to service this product yourself, except as specifically explained in this User’s Guide. Refer all other servicing to qualified service personnel.

Maintaining the Projector

Your projector needs little maintenance. All you have to do on a regular basis is keep the lens cover glass clean. Any dirt or smears on the lens cover glass may show up on your projected image.

You may need to clean the air filter. A clogged air filter can block ventilation needed to cool the projector and cause overheating.

The only parts you should replace are the lamp and air filter. If any other part needs replacing, contact your dealer or a qualified servicer.

This chapter covers the following:

- Cleaning the lens cover glass
- Cleaning the projector case
- Cleaning the air filter
- Replacing the air filter
- Replacing the lamp
- Transporting the projector
Cleaning the Lens Cover Glass

Clean the lens cover glass whenever you notice dirt or dust on the surface.

- Use a canister of compressed air to remove dust.
- To remove dirt or smears on the lens, use a commercially available cloth for cleaning eyeglasses.

Cleaning the Projector Case

Before you clean the case, first turn off the projector and unplug the power cord.

- To remove dirt or dust, wipe the case with a soft, dry, lint-free cloth.
- To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral detergent. Then wipe the case.
- Do not use wax, alcohol, benzene, paint thinner, or other chemical detergents. These can damage the case.
Cleaning the Air Filter

Clean the air filter when you see any of the following messages: The air filter is clogged. Clean or replace the air filter. or Check or Replace the air filter. Dust clogs prevent proper ventilation and can cause overheating and damage the projector.

Follow these steps:

1. Turn off the projector and unplug the power cord.
2. To clean the filter, Epson recommends using a small vacuum cleaner designed for computers and other office equipment. If you don’t have one, gently clean the filter using a very soft brush (such as an artist’s paint brush).

   You can remove the air filter to clean both sides.

3. When you have finished cleaning the air filter, close the cover and reset the timer as described on page 88.
4. If the dirt is difficult to remove or a filter is broken, replace the filter as described below.

Replacing the Air Filter

Replace the air filter when you see the Check or Replace the air filter message. Dust clogs prevent proper ventilation and can cause overheating and damage the projector.

To obtain a replacement air filter, contact your dealer or call Epson at (800) 873-7766 in the United States to obtain a new one. In Canada, please call (800) 463-7766 for dealer referral.

note

If the air filter has been stained by tobacco smoke, it cannot be cleaned. Replace the filter as described below.
Follow these steps:

1. Turn off the projector and unplug the power cord.
2. Remove the air filter by lifting up on the two tabs to release them.
3. Remove the air filter by pulling the center of the air filter straight out.
4. Insert the new air filter with the tab facing the front of the projector.
5. Close the air filter cover.
6. Reset the air filter timer as described in the next section.

**Resetting the Air Filter Timer**

1. Plug the projector in and turn it on.
2. Press the **Menu** button on the remote control, select **Reset Air Filter Time** from the Reset menu, then press **Enter**.
3. When you see the confirmation message, select **Yes**, then press **Enter**.
4. When you’re finished, press **Menu** to exit the menu system.

---

**note**

If the air filter has been stained by tobacco smoke, it cannot be cleaned. Replace the filter.

---

**note**

The air filter usage timer shows 0H until you’ve used the filter for at least 10 hours.
Replacing the Lamp

The projection lamp typically lasts about 4000 hours. It is time to replace the lamp when:

- The projected image gets darker or starts to deteriorate.
- The message Replace the Lamp appears on the screen and when the lamp comes on and the lamp warning light flashes orange. To maintain projector brightness and image quality, replace the lamp as soon as possible.
- The lamp warning light flashes red (the lamp is burnt out).

Contact your dealer or contact an Epson authorized reseller for a replacement lamp. Request part number V13H010L45. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).

Follow these steps to replace the lamp:

1. Turn off the projector.
2. When the Power light stops flashing, unplug the power cord.
3. Let the projector cool for at least an hour (if it has been on). The lamp is extremely hot immediately after use.
4. To release the lamp cover, insert the screwdriver included with the new lamp as shown, then remove the cover.

Note

Turn off the projector when not in use to prolong the life of the projector lamp.

You can check how long the lamp has been in use (see page 91).

Lamp life results will vary depending upon mode selected, environmental conditions and usage.

Warning

Let the lamp cool fully before replacing it.

In the unlikely event that the lamp has broken, small glass fragments may be present and should be removed carefully to avoid injury.
5. Loosen the two screws holding the lamp in place (you can’t remove them).

6. Pull the lamp straight out.

**note**

The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.

7. Gently insert the new lamp.

8. Once the lamp is fully inserted, tighten its screws and replace the cover. (The projector won’t come on if the lamp cover is loose.)

9. Reset the lamp timer as described in the next section.
Resetting the Lamp Timer

After you replace the lamp, you need to reset the lamp timer using the projector’s menu.

1. Plug the projector in and turn it on.
2. Press the Menu button on the remote control, select Reset Lamp Hours from the Reset menu, then press Enter.
3. When you see the confirmation message, select Yes, then press Enter.
4. When you’re finished, press Menu to exit the menu system.

Transporting the Projector

The projector contains many glass and precision parts. Follow these guidelines to prevent injury or damage:

- When hand-carrying the projector, you should use the handle to lift it only a short distance (for example, to set it on a table).
- When shipping the projector for repairs, use the original packaging material if possible. If you do not have the original packaging, use equivalent materials, placing plenty of cushioning around the projector.
- When transporting the projector a long distance, first place it in a hard-shell shipping case, and then pack it in a firm box, placing cushioning around the case.

Note

The lamp usage timer shows 0H until you’ve used the lamp for at least 10 hours.

Note

Epson shall not be liable for any damages incurred during transportation.
This chapter helps you solve problems with your projector, and tells you how to contact technical support for problems you can’t solve yourself. This chapter explains the following:

- Using the projector’s on-screen help system
- What to do when the projector’s status lights flash
- Solving problems with the image or sound
- Solving password problems
- Solving problems with EMP Monitor
- Solving problems with the remote control
- Contacting technical support

7 Solving Problems

This chapter helps you solve problems with your projector, and tells you how to contact technical support for problems you can’t solve yourself. This chapter explains the following:

- Using the projector’s on-screen help system
- What to do when the projector’s status lights flash
- Solving problems with the image or sound
- Solving password problems
- Solving problems with EMP Monitor
- Solving problems with the remote control
- Contacting technical support
Using On-Screen Help

If the image doesn’t look right or your audio isn’t working, you can get help by pressing the blue ? Help button on top of the projector or on the remote control. The following choices are available:

- No image appears on the screen
- The image is not in focus
- The image is unsteady
- The image colors don’t look right
- The image is too dark
- The image is distorted

Follow these steps to get help:

1. Press the green ? Help button on the projector.

You see the Help menu:

2. Use the pointer button on the remote control or the arrow buttons on the projector to highlight menu items.

3. After highlighting a menu item, press the Enter button on the remote control or on the projector to select it.

4. To exit the Help system, press the ? Help button.
If none of the suggestions solves your problem, see additional solutions to problems in the following sections.

**Checking Projector Status**

If your projector isn’t working correctly, first turn it off, wait for it to cool (the `Power` light stops flashing orange), and unplug it. Then plug the power cord back in and turn on the projector. If this doesn’t solve the problem, check the lights on top of the projector.

**What To Do When the Lights Flash**

The lights on top of the projector indicate the projector’s status and let you know when a problem occurs.

Refer to the following table for a complete description of the projector’s status lights and their meaning:

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Power</code> Orange</td>
<td>The projector is in sleep mode. You can unplug it or press the <code>Power</code> button to turn it on.</td>
<td></td>
</tr>
<tr>
<td><code>Power</code> Flashing green</td>
<td>The projector is warming up. Wait for the image to appear.</td>
<td></td>
</tr>
<tr>
<td><code>Power</code> Green</td>
<td>The projector is operating normally.</td>
<td></td>
</tr>
<tr>
<td><code>Power</code> Red</td>
<td>High Temperature Warning. Although this is not an abnormal condition, projection will stop automatically if the temperature rises too high again. Make sure there is plenty of space around and under the projector for ventilation, and that the air filter is clean (see page 87).</td>
<td></td>
</tr>
<tr>
<td>Light</td>
<td>Status</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>It's time to replace the lamp. See page 89 for instructions. If you continue</td>
</tr>
<tr>
<td></td>
<td>Flashing orange</td>
<td>to use the lamp after the replacement warning, there is an increased</td>
</tr>
<tr>
<td></td>
<td></td>
<td>possibility that the lamp may break.</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>No air filter. Make sure that the air filter is securely installed; see page</td>
</tr>
<tr>
<td></td>
<td>Orange</td>
<td>87. If the error continues when the air filter is installed, there is a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>problem with the air filter sensor. Stop using the projector, disconnect</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the power cord, and contact Epson as described on page 106.</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>Low air flow. If you see a message saying that the air filter is clogged,</td>
</tr>
<tr>
<td></td>
<td>Flashing orange</td>
<td>make sure that the air filter is clean. If it is clogged, clean it or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>replace it with a new filter; see page 87.</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>There is a problem with the fan or temperature sensor. Stop using the</td>
</tr>
<tr>
<td></td>
<td>Flashing red</td>
<td>projector, disconnect the power cable, and contact Epson as described</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>on page 106.</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>The projector is overheating, which turns the lamp off automatically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wait until the cooling fan stops, about five minutes, then unplug the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>power cord. Plug the power cord back in and press the Power button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make sure the room temperature is not above 95 °F (35 °C) and there is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>plenty of space around and under the projector for ventilation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The air filter may be clogged. Clean or replace it as described on page 87.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the projector continues to overheat after you clean the air filter, the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>problem may be caused by damage to the cooling fan or temperature sensor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact Epson for help.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Warning:</strong> Except as specifically explained in this <em>User’s Guide</em>, do</td>
</tr>
<tr>
<td></td>
<td></td>
<td>not attempt to service this product yourself.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you installed the optional Epson smoke filter in the projector, try the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ If you are using the projector at a high altitude (4,900 feet [1500</td>
</tr>
<tr>
<td></td>
<td></td>
<td>meters] or higher), set High Altitude Mode to On (see page 61).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ You may need to set the Brightness Control to Low (see page 59).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Replace the smoke filter (see page 87).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the error continues, stop using the projector, disconnect the power</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cable from the electrical outlet, and contact Epson as described on page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>106.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Light Status Description</strong></td>
</tr>
</tbody>
</table>
Viewing Lamp Usage and Other Information

Use the Info menu to view information about the image source, the display settings of your computer, and the number of hours the lamp and filter has been used.

Press the Menu button, select Info, then press Enter.

You see the lamp and air filter usage hours and various input signal settings on the right:

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔥🔥</td>
<td>Red Flashing red</td>
<td>The lamp may be burned out. First make sure the lamp cover is securely installed. If that’s not the problem, remove the lamp and replace it as described on page 89. If this does not resolve the problem, contact Epson as described on page 106. The lamp may be cracked or installed incorrectly. Check the lamp; if it is cracked, you must replace it (as described on page 89) before you can use the projector again. If checking the lamp installation and replacing the lamp does not solve the problem, contact Epson as described on page 106.</td>
</tr>
<tr>
<td>🔥🔥</td>
<td>Red Flashing red</td>
<td>The projector is shut down automatically because of an internal problem. Remove the power cord and contact Epson for help, as described on page 106.</td>
</tr>
</tbody>
</table>

The lamp typically lasts about 4000 hours. If the number shown is close to that, make sure you have a spare lamp handy. If you’ve installed a new lamp, be sure to reset the lamp timer (see page 91).
**Solving Problems with the Image or Sound**

**The Power light does not come on.**

Make sure the power cord is connected securely both at the power outlet and the projector. If you have just replaced the lamp, make sure the cover is securely fastened.

**No image appears on the screen.**

- Check that the Power light is green and not flashing.
- The projector may be in sleep mode. If the Power light is orange, press the Power button to turn the projector on.
- Try pressing the other Power button on the remote control or on the projector.
- Press the A/V Mute button to make sure the picture has not been turned off temporarily.
- The attached computer may be in sleep mode or displaying a black screen saver. Try pressing a key on the computer.

**You’ve connected a computer and see a blue screen with the message No Signal displayed.**

- Make sure the cables are connected correctly, as described in Chapter 1.
- Try restarting your computer.
- If you’ve connected a computer and one or more video sources, you may need to press the Source Search button on the projector or remote control to select the correct source. Allow a few seconds for the projector to sync up after pressing the button.
If you’re using a PC notebook:

- Hold down the Fn key on the keyboard and press the function key that lets you display on an external monitor. It may have an icon such as 📺/🖥, or it may be labelled CRT/LCD. Allow a few seconds for the projector to sync up after pressing it. Check your notebook’s manual or online help for details.

  On most systems, the 📺/🖥 key lets you toggle between the LCD screen and the projector, or display on both at the same time.

- Depending on your computer’s video card, you might need to use the Display utility in the Control Panel to make sure that both the LCD screen and external monitor port are enabled. See your computer’s documentation or online help for details.

If you’re using Mac OS X:

1. Open System Preferences.
2. Double-click Displays.
3. Make sure the VGA Display or Color LCD dialog box is selected.
4. Click the Arrange tab.
5. Make sure the Mirror Displays checkbox is selected.

The message Not Supported is displayed.

- Make sure the correct input signal is selected in the Settings menu (see page 57).

- Make sure your computer’s resolution doesn’t exceed UXGA (1600 ×1200), and the refresh rate is supported by the projector (see page 116). If necessary, change your computer’s resolution setting as described in the following section.

Only part of the computer image is displayed.

- Press the Auto button on the remote control.

- Make sure the image Position setting is correct on the Signal menu. See Chapter 4 for more information.
Make sure your computer’s resolution setting is correct. Ideally, it should be 1024 x 768 to match the projector’s native resolution. If this option isn’t available, select one of the other compatible video formats listed on page 116.

- **Windows:**
  
  Right-click the desktop, select Properties, click the Settings tab, and select a different resolution.

- **Mac OS X:**
  
  Open System Preferences, double-click Displays, and then select a different resolution.

You also may need to modify existing presentation files if you created them for a different resolution. See your software documentation for specific information.

### The image isn’t square, but keystone-shaped.

- If the top or bottom of the image is broader, press the ▲ or ▼ button on the projector until the image is square.

- If the projector is angled toward the screen from the left or right, the image will be broader on one side. Center the projector in front of the middle of the screen, facing the screen squarely.

### The image contains static or noise.

- Make sure the correct Input Signal is selected in the Signal menu (see Chapter 4).

- If you’re using a computer cable longer than 6 feet (2 meters), or an extension cable, the image quality may be reduced.

- Keep your computer and video cables away from the power cord as much as possible to prevent interference.

- The video signal may be split between the computer and the projector. If you notice a decline in the projected image quality when the image is displayed simultaneously on your notebook computer and the projector, turn off the notebook’s LCD display.
The image is blurry.

- There may be dirt or smears on the lens cover glass. Clean the lens cover glass as described on page 86.
- Adjust the focus using the focus ring.
- Make sure the lens is not fogged by condensation. You may need to wait before using the projector after moving it from a cold environment to a warm environment.
- Make sure the projector is within the recommended projection distance (2.7 to 48.2 feet [0.83 to 14.69 meters]).
Adjust the Sharpness setting on the Image menu (see Chapter 4). When you change video settings, you should be able to see the effect on the screen immediately. If you’re projecting from a computer, you may also need to adjust the tracking and sync as described in the next section. If you don’t like the new settings, you can always select Reset to return to the factory default settings.

You see vertical stripes, or the image still looks blurry after trying the solutions in the previous section.

If you’re projecting from a computer and displaying an image that contains a lot of fine detail, you may notice one or more vertical stripes or bands, or some of the characters may look heavy or blurred. Press the Auto button on the remote control. This resets the projector’s tracking and sync settings.

If further adjustment is needed, you can fine-tune the Tracking and Sync settings manually using the Signal menu as described in Chapter 4.

1. Fill the screen with an image containing fine detail when making these adjustments. For example, in Windows you can select a pattern to appear as your desktop background. If this option isn’t available, try projecting black text on a white background.

2. Adjust the Tracking to eliminate vertical stripes.

3. Adjust the Sync setting to increase the sharpness of the image.
The colors of the image are not right.

- If you’re displaying a computer image, use the Color Mode option in the projector’s Image menu to adjust the color. If you’re displaying video, adjust the Color, Tint, and Color Mode settings on the Image menu.
- Try changing the Color Adjustment setting on the Image menu.
- Check your computer display settings to correct the color balance.

There is no sound.

- Make sure the A/V Mute button has not been pressed.
- Try adjusting the Volume setting in the Settings menu (see page 59).
- If you’re using a VCR or other video source, make sure the volume is not turned all the way down or muted. Also, make sure the cables are connected correctly, as described in Chapter 1.
- If your presentation includes computer audio, make sure the volume control on your computer is not turned all the way down or muted. If you’re using the audio cable, make sure it is securely connected to both the projector and your computer’s headphone jack or audio out jack.
- Make sure the Windows volume controls on your computer are not turned all the way down or set to Mute. You may be able to check this by clicking the volume control in your Windows System Tray (lower right corner of the screen).
Solving Password Problems

You have forgotten the password.

- Write down the request code that appears in the Password Protect Release screen and contact Epson. See page 106.
- If you turned on the password protect feature before setting the password and no password was set before, try using the default password: 0000.

The remote control is not available.

You must have the remote control to enter the password. You can purchase a replacement remote control from Epson. See page 107.

Solving EMP Monitor Problems

You don’t see your projector in the EMP Monitor window.

- Make sure that you’ve connected the projector to the network and configured it correctly; see page 75. Also, make sure you’ve registered the projector with EMP Monitor. See page 79.
- Make sure that Standby Mode in the Extended menu is set to Network On.
- If the computer you are using is running Windows XP, 2000, or NT 4.x, you must be logged in as the Administrator.
- Try restarting your computer.
Solving Problems with the Remote Control

The projector doesn’t respond to remote control commands.

■ If you’re using the remote control for the first time, make sure the batteries are installed, as shown on page 43.

■ The remote control’s batteries may not be installed correctly or may be low on power. To change the battery, see page 43.

■ Make sure you are within 33 feet (10 meters) of the projector, and within range of the projector’s front or back sensor (approximately 30° to the left or right and 15° above or below).

■ Dim the room lights and turn off any fluorescent lights. Make sure the projector is not in direct sunlight. Strong lighting, especially fluorescent lights, may affect the projector’s infrared receivers. Also, turn off any nearby equipment that emits infrared energy, such as a radiant room heater.

■ Make sure the projector’s remote receivers aren’t turned off; see page 59.
Where To Get Help

Internet Support

Visit Epson’s support website at epson.com/support and select your product for solutions to common problems. You can download utilities and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Visit http://www.presentersonline.com to access tips, templates, and training for developing successful presentations.

Speak to a Support Representative

To use the Epson PrivateLine Support service, call (800) 637-7661 and enter the PIN on the included Epson PrivateLine Support card. This is the fastest way of speaking to a live representative, and it’s free. This service is available 6 AM to 6 PM, Pacific Time, Monday through Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one of these numbers:

- U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday through Friday.
- Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Before you call, please have the following information ready:

- Product name (PowerLite 6110i)
- Product serial number (located on the back of the projector)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer or video configuration
- Description of the problem
Purchase Supplies and Accessories

You can purchase screens, carrying cases, or other accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).
This appendix provides guidelines on installing the projector in a permanent location, such as a theater or conference room.

Installation Guidelines

The projector can be installed for four different viewing setups: front projection, ceiling mounting, rear projection onto a semi-transparent screen, or rear/ceiling projection, as shown:
To project from overhead, you’ll need the optional ceiling mounting hardware; see page 14 for ordering information. You’ll also need to select Front/Ceiling or Rear/Ceiling in the projector’s Extended menu to flip the image upside-down. To project from the rear, select Rear (see page 61).

If you’re mounting the projector on the ceiling and you place it above screen level, you’ll have to tilt it down to position the image on-screen. This causes the image to lose its square shape. You can then correct the distortion by using the Keystone function in the projector’s menu system (see page 58) or by using the ▲ or ▼ buttons on the projector’s control panel.

If you place the projector so that the lens is level with the bottom of the screen, the image will be square and you won’t have to adjust it. If you place the lens lower than the bottom of the screen, you may have to tilt the projector upward if you want to fill the whole screen with the image.

If you want to be able to control the projector’s settings from a remote computer, see Chapter 5.
Installing the Rear Cable Cover and Lock

If you’re mounting the projector on the ceiling, you can install the rear cable cover to enhance the cosmetic appearance of the system. To install the cover, insert the cover’s tabs into the slots as shown, then attach it with the two included screws.

For security purposes, you can also install a lock to ensure that the cable cover is not removed.
Technical Specifications

**General**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of display</td>
<td>Poly-silicon TFT active matrix</td>
</tr>
<tr>
<td>Size of LCD panels</td>
<td>Diagonal: 0.8 inch</td>
</tr>
<tr>
<td>Resolution (native format)</td>
<td>1024 × 768 pixels (XGA)</td>
</tr>
<tr>
<td>Color reproduction</td>
<td>24 bit, 16.7 million colors</td>
</tr>
<tr>
<td>Brightness</td>
<td>3500 lumens (high brightness mode)</td>
</tr>
<tr>
<td></td>
<td>2700 lumens (low brightness mode)</td>
</tr>
<tr>
<td>Contrast ratio</td>
<td>600:1</td>
</tr>
<tr>
<td>Image size</td>
<td>30 to 300 inches</td>
</tr>
<tr>
<td>Projection distance</td>
<td>2.7 to 48.2 feet (0.83 to 14.69 meters)</td>
</tr>
<tr>
<td>Projection methods</td>
<td>Front, rear, upside-down (ceiling mount)</td>
</tr>
<tr>
<td>Internal sound system</td>
<td>5 W monaural</td>
</tr>
<tr>
<td>Optical aspect ratio</td>
<td>4:3 (horizontal:vertical)</td>
</tr>
<tr>
<td>Zoom ratio</td>
<td>1 to 1.6</td>
</tr>
<tr>
<td>Noise level</td>
<td>39 dB standard filter; 43dB smoke filter</td>
</tr>
<tr>
<td>Keystone correction</td>
<td>± 30° (vertical)</td>
</tr>
</tbody>
</table>
### Projection Lamp

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>UHE (Ultra High Efficiency)</td>
</tr>
<tr>
<td>Power consumption</td>
<td>230 W</td>
</tr>
<tr>
<td>Lamp life</td>
<td>Up to 4000 hours</td>
</tr>
<tr>
<td>Part number</td>
<td>V13H010L45</td>
</tr>
</tbody>
</table>

**note**

Turn off this product when not in use to prolong the life of the projector.

Lamp life results will vary depending upon mode selected, environmental conditions and usage.

### Remote Control

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>19.7 feet (6 meters)</td>
</tr>
<tr>
<td>Batteries (2)</td>
<td>Alkaline size AAA</td>
</tr>
</tbody>
</table>

### Dimensions

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>5.75 inches (146 mm) [not including feet]</td>
</tr>
<tr>
<td>Width</td>
<td>18.3 inches (465 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>13.39 inches (340 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>15.4 lb (7 kg) [without cable cover]</td>
</tr>
</tbody>
</table>

### Electrical

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated frequency</td>
<td>50/60 Hz AC</td>
</tr>
<tr>
<td>Power supply</td>
<td>100 to 120 VAC, 3.8 A</td>
</tr>
<tr>
<td></td>
<td>200 to 240 VAC, 1.7 A</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Operating: 331 W</td>
</tr>
<tr>
<td></td>
<td>Standby: 0.4 W with Network Off</td>
</tr>
<tr>
<td></td>
<td>10.4 W with Network On</td>
</tr>
</tbody>
</table>
### Environmental

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Operating: 32 to 104 °F (0 to 40 °C)</th>
<th>Storage: 14 to 140 °F (–10 to 60 °C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Humidity</td>
<td>Operating: 20 to 80% RH, non-condensing</td>
<td>Storage: 10 to 90% RH, non-condensing</td>
</tr>
<tr>
<td>Operating altitude</td>
<td>0 to 10,000 ft (0 to 3,048 m)</td>
<td></td>
</tr>
</tbody>
</table>

### Safety

<table>
<thead>
<tr>
<th>Region</th>
<th>Standards</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>FCC Part 15B Class B</td>
</tr>
<tr>
<td></td>
<td>UL60950-1</td>
</tr>
<tr>
<td>Canada</td>
<td>ICES-003 Class B</td>
</tr>
<tr>
<td></td>
<td>CSA C22.2 No. 60950-1</td>
</tr>
</tbody>
</table>

Pixelworks™ DNX™ ICs are used in this projector.
Compatible Video Formats

The projector supports NTSC, PAL, and SECAM international video standards, as well as the monitor display formats listed below.

To project images output from a computer, the computer’s video card must be set at a refresh rate (vertical frequency) that’s compatible with the projector; see the following table for compatible formats. As noted below, some images are automatically resized to display in the projector’s “native” format (XGA). In addition, the frequencies of some computers may not allow images to display correctly; see your computer’s documentation for details.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Refresh Rate (Hz)</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGAEGA</td>
<td>70</td>
<td>640 × 350*</td>
</tr>
<tr>
<td>VGA—60</td>
<td>60</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VGA—72</td>
<td>72</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VGA—75</td>
<td>75</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VGA—85</td>
<td>85</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>SVGA—56</td>
<td>56</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—60</td>
<td>60</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—72</td>
<td>72</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—75</td>
<td>75</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—85</td>
<td>85</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>XGA—60</td>
<td>60</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—70</td>
<td>70</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—75</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—85</td>
<td>85</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>SXGA1—70</td>
<td>70</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA1—75</td>
<td>75</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA1—85</td>
<td>85</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA2—60</td>
<td>60</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA2—75</td>
<td>75</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA2—85</td>
<td>85</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA3—60</td>
<td>60</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>SXGA3—75</td>
<td>75</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>SXGA3—85</td>
<td>85</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>UXGA—60</td>
<td>60</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>Mode</td>
<td>Refresh Rate (Hz)</td>
<td>Resolution</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>MAC13</td>
<td>67</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>MAC16</td>
<td>75</td>
<td>832 × 624*</td>
</tr>
<tr>
<td>MAC19</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC19</td>
<td>60</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC21</td>
<td>75</td>
<td>1152 × 870*</td>
</tr>
<tr>
<td>NTSC</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>SECAM</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>SDTV (480i)</td>
<td>60</td>
<td>720 × 480*</td>
</tr>
<tr>
<td>SDTV (576i)</td>
<td>50</td>
<td>720 × 576*</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>60</td>
<td>720 × 480*</td>
</tr>
<tr>
<td>SDTV (576p)</td>
<td>50</td>
<td>720 × 576*</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>50/60</td>
<td>1280 × 720*</td>
</tr>
<tr>
<td>HDTV (1125i)</td>
<td>50/60</td>
<td>1920 × 1080*</td>
</tr>
</tbody>
</table>

*The image is resized using Epson’s SizeWise™ Technology.*
Notices

This appendix includes safety instructions and other important information about your PowerLite projector.

Important Safety Instructions

Follow these safety instructions when setting up and using the projector:

■ Do not place the projector on an unstable cart, stand, or table.
■ Do not use the projector near water or sources of heat.
■ Use the type of power source indicated on the projector. If you are not sure of the power available, consult your dealer or power company.
■ Place the projector near a wall outlet where the plug can be easily unplugged.
■ Insert the projector’s three-wire grounding-type plug into a properly grounded outlet. If you have a two-prong outlet, contact an electrician to replace it. Do not hold the plug with wet hands.
■ Take the following precautions for the plug. Failure to comply with these precautions could result in sparks or fire: Do not insert the plug into an outlet with dust present. Insert the plug firmly into the outlet.
■ Do not overload wall outlets, extension cords, or integral convenience receptacles. This can cause fire or electric shock.
■ Do not place the projector where the cord can be walked on. This may result in fraying or damage to the plug.
■ Unplug the projector from the wall outlet before cleaning. Use a damp cloth for cleaning. Do not use liquid or aerosol cleaners.
■ Do not block the slots and openings in the projector case. They provide ventilation and prevent the projector from overheating. Do not operate the projector on a sofa, rug, or other soft surface, or in a closed-in cabinet unless proper ventilation is provided.
■ Never push objects of any kind through the cabinet slots. Never spill liquid of any kind into the projector.
Except as specifically explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified personnel. Opening or removing covers may expose you to dangerous voltages and other hazards.

Unplug the projector from the wall outlet and refer servicing to qualified service personnel under the following conditions: When the power cord or plug is damaged or frayed. If liquid has been spilled into the projector, or if it has been exposed to rain or water. If it does not operate normally when you follow the operating instructions, or if it exhibits a distinct change in performance, indicating a need for service. If it has been dropped or the housing has been damaged.

The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.

Unplug the projector during lightning storms or when it will not be used for extended periods.

Do not stand on the projector or place heavy objects on it.

Do not use the projector outside of the required temperature range of 41 to 104 °F (5 to 40 °C). Doing so may cause an unstable display and could lead to projector damage.

Do not store the projector outside of the required temperature range of 14 to 140 °F (–10 to 60 °C) or in direct sunlight for long periods of time. Doing so may cause damage to the case.

WARNING: The cords included with this product contain chemicals, including lead, known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling. (provided in accordance with Proposition 65 in Cal. Health & Safety Code § 25249.5 et seq)
FCC Compliance Statement

For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.
Index

A

A/V Mute, 44, 60, 98
Accessories, 14, 107
Adjustment Level setting, 62
Air filter
  cleaning, 87
  high efficient, 14
  number of hours used, 65
  ordering, 14
  replacing, 87 to 88
  smoke, 14
  timer, resetting, 88
Air Filter Setting, 62
Alarm Timer setting, 62
AMX device discovery setting, 77
Anti-theft device, 14, 17
Aspect button, 46
Aspect ratio, 46, 58, 113
Aspect setting, 58
Audio
  adjusting volume, 38, 59
  cable, 10, 28
  connecting equipment, 27 to 28
  problems, troubleshooting, 103
  turning off (using A/V Mute), 44
Auto button, 38, 57
Auto Setup setting, 38, 57

B

Background setting, 60, 68
Banding in image, 102
Batteries, replacing, 43
Blackboard color mode, 55
Blank screen, 33 to 34, 98 to 99
Blue background, 60
Blurry image, 101
Brightness, 9, 113
Brightness Control setting, 59
Brightness Correct setting, 62
Brightness setting, 55
Browser, monitoring projector with, 83 to 84
Buttons, disabling projector, 59, 72

C

Cables
  BNC, 23
  component-to-VGA, 21
  composite (RCA), 19
  HD15-to-component, 14, 21
  illustrations, 13
  network, 75
  ordering, 14
  security, 14, 17
  S-Video, 13, 14, 20
  VGA computer, 13, 25
  VGA-to-component, 14, 21
Camcorder, connecting to, 18 to 23
Ceiling
  mount, 14, 109
  projection, 61, 110
Clean notice timing setting, 62
Cleaning
  air filter, 87
  lens cover glass, 86
  projector case, 86
Closed Caption setting, 60
Color
  adjusting, 54 to 55, 62
  problems, 103
  specifications, 113
Color Adjustment setting, 55
Color Mode setting, 54
Color Saturation setting, 55
Component video cable, 21
Component video source, selecting, 32
Component-to-VGA video cable, 14, 21
Composite (RCA) video cable, 18 to 19
Computer
cable, 13, 24 to 25
correcting images, 38
selecting source, 32
supported display formats, 116 to 117
Connecting projector
to a computer, 24 to 25
to a game console, 18 to 23
to a video source, 18 to 23
to audio equipment, 27 to 28
to external monitor, 26
Contrast ratio, 9, 113
Contrast setting, 55

D
Default password, 66
Default settings, restoring, 53
DHCP setting, 76
Digital camera, connecting to, 18 to 23
Dimensions, 114
Direct Power On setting, 61
Display setting, 60
Distance from projector to screen, 16, 113
Display setting, 60
Distance from projector to screen, 16, 113

E
Electrical specifications, 114
E-mail alerts, 77 to 78, 82
EMP Monitor
monitoring the projector, 78 to 83
problems, 104
system requirements, 74
using, 78 to 83
Enter button, 42
Entering the password, 72
Environmental specifications, 115

F
FCC compliance statement, 121
Filter, see Air filter
Focusing image, 35
Freeze button, 45
Front projection, 61, 109
Front/Ceiling projection, 61, 109
Full lock setting, 59, 72

G
Game color mode, 54
Game console, connecting to, 18 to 23
Gateway Address setting, 76

H
Height of image, adjusting, 36
Help system, using, 94 to 95
Help, Epson, 11, 106 to 107
High Altitude Mode setting, 61
High brightness, 59, 113
HP OpenView, 73
iBook, connecting to projector, 24 to 25
iMac, connecting to, 24 to 25
Image
  adjusting, 35 to 38, 54 to 58
  capturing and saving in projector, 66 to 68
  correcting shape, 37 to 38, 100
  fitting on screen, 16, 35, 99 to 100
  focusing, 35
  freezing, 45
  height, adjusting, 36
  menu, 54 to 55
  positioning, 36, 57
  problems with, 98 to 103
  raising, 36
  selecting source, 32, 44
  shape, correcting, 37 to 38
  size and projection distance, 16, 113
  turning off (using A/V Mute), 44
  zooming, 35, 45
Image Correction setting, 62
Info menu, 64 to 65, 97
Input signal, selecting, 32, 44
Installing projector, 109 to 110
Installing software, 74
Instant Off feature, 39
IP Address setting, 76
Kensington anti-theft device, 14, 17
Keystone correction, 37 to 38, 58, 100, 110, 113
Lamp
  automatic shutoff, 39
  brightness, 59
  number of hours used, 64, 97
  ordering, 14
  replacing, 89 to 91
  specifications, 114
  status light, 95 to 97
  timer, resetting, 91
Language setting, 63
LCD panels, 113
Lens
  access door, 35
  cover glass, cleaning, 86
Lights, status, 95 to 97
Logo
  creating, 66 to 68
  displaying, 61, 68 to 69
  protecting, 70
Low brightness, 59, 113
MacBook, connecting to, 24 to 25
Mail setting, 77
Manuals, 11
Menus
  changing settings, 52 to 53
  default settings, restoring, 53
  Extended, 60 to 63
  Image, 54 to 55
  Info, 64 to 65, 97
  Network, 63, 76 to 78
  Reset, 53
  Settings, 58 to 59
  Signal, 56 to 58
  using, 52 to 53
Messages setting, 60
Monitor, connecting external, 26
Monitoring projector
  e-mail notifications, 77 to 78, 82
  EMP Monitor, 78 to 83
  HP OpenView, 73
    with browser, 83 to 84
Moving projector, 91
Multiple projectors, controlling, 47 to 49
Multi-screen setting, 62
Index

Network
  connecting to, 75
  managing projector remotely, 73 to 84
  menu, 63, 76 to 78
  problems, 104
  settings, 63, 76 to 78
  system requirements, 74
Network Protect password, 70
New Hardware Wizard, 31
No Signal message, 33, 98 to 99
Noise level, 113
Notebook computer
  connecting to projector, 25
  display problems, 33 to 34, 98 to 100
  selecting source, 32
Operation Lock setting, 59, 72
Operation setting, 61
Optical aspect ratio, 113
Options for projector, 13 to 14
Password
  default, 66
  entering, 72
  logo protection, 70
  Network Protect, 70
  problems, 72, 104
  prompt, 66, 72
  request code, 72
  setting, 69
  turning on, 71
Photo color mode, 54
Picture source, selecting, 32, 44
Picture, see Image
Pixelworks, 115
PJLink Password, 76
Pointer Shape setting, 59
Pointer tool, using, 46 to 47
Position setting, 57
Positioning
  image, 36
  projector, 16
Power
  button, 31
  consumption, 114
  light, 95 to 97
  saving, 61
  specifications, 114
  status light, 31, 95 to 97
  supply, 114
PowerBook, connecting to projector, 24 to 25
Presentation color mode, 54
Presentations
  tips and training, 11
  using the pointer tool, 46 to 47
Presenters Online, 11, 106
PrivateLine Support, 11, 106
Problems
  color, 103
  image, 98 to 103
  monitoring projector, 104
  no signal, 33, 98 to 99
  password, 72, 104
  remote control, 105
  sound, 103
  using on-screen help, 94 to 95
Progressive setting, 57
Projection distance, 16, 113
Projection lamp, see Lamp
Projection setting, 61
Projector
  accessories, 14
  cleaning, 86
  connections, see Connecting projector
disabling buttons, 59, 72
distance from screen, 16, 113
feet, adjusting height with, 36
installing, 109 to 110
lamp specifications, 114
monitoring remotely, 73 to 84
options, 14
password protection, 71
positioning, 16 to 17
resolution, 113
specifications, 113 to 115
transporting, 91
troubleshooting, 93 to 97
turning off, 39
turning on, 30 to 31
unpacking, 13
  viewing information about, 97
Projector ID, setting, 48
Projector Name setting, 77

Q
Quick Setup sheet, 11

R
Raising image, 36
RCA Audio Input setting, 59
RCA-style video cable, 19
Rear projection, 61, 109
Rear/Ceiling projection, 61, 109
Registration, 12
Remote control
  batteries, 114
  controlling multiple projectors, 47 to 49
  ID, 48 to 49
  problems, 105
  range, 114
  receivers, disabling, 59
  replacing batteries, 43
  specifications, 114
  troubleshooting, 105
  using, 41 to 47
Remote Receiver setting, 59
Replacing
  air filter, 87 to 88
  lamp, 89 to 91
  remote control batteries, 43
Request code, password, 72
Resetting
  air filter timer, 88
  lamp timer, 91
  menu options, 53
Resolution, 113

S
Safety
  instructions, 119 to 120
  specifications, 115
Screen
  blank, 33 to 34, 98 to 99
  distance from projector, 16, 113
  ordering, 14
Screen ID setting, 62
Screen image, See Image
SDTV formats, supported, 117
Security, Kensington lock, 14, 17
Settings menu, 58 to 59
Sharpness setting, 55
Signal menu, 56 to 58
Sleep mode, 39, 61
SNMP setting, 77
Software installation, 74
Sound
  adjusting, 38, 59
  troubleshooting, 103
Source
  selecting, 32, 44
  viewing, 97
Speaker, specifications, 113
Speakers, connecting, 28
Specifications
  brightness, 113
  dimensions, 114
  electrical, 114
  environmental, 115
  general, 113
  lamp, 114
  remote control, 114
  resolution, 113
  safety, 115
  speaker, 113
Sports color mode, 54
sRGB color mode, 55
Standby Mode setting, 61
Startup Screen setting, 60
Status lights, 95 to 97
Stripes in image, 102
Subnet Mask setting, 76
Support, Epson, 11, 106 to 107
S-Video cable, 13, 14, 20
Switching picture source, 32, 44
Sync. setting, 57
Synchronization, adjusting, 38, 57, 102
System requirements, network, 74

Troubleshooting
  blank screen, 33 to 34, 98 to 99
  color, 103
  cut-off image, 99 to 100
  distorted image, 37
  Easy Management, 104
  image and sound problems, 98 to 103
  image quality, 100 to 102
  image shape, 100
  network problems, 104
  no image, 98
  no signal, 33, 98 to 99
  no sound, 103
  password, 104
  projector problems, 93 to 97
  remote control problems, 105
Turning off
  picture, 44
  projector, 39
  sound, 44
Turning off picture (using A/V Mute), 60, 98
Turning off projector, 39
Turning on
  password, 71
  projector, 30 to 31
  User’s Logo, 68 to 69
Typing the password, 69

U
Unpacking projector, 13
User’s Logo
  creating, 66 to 68
  displaying, 68 to 69
  User’s Logo setting, 61

V
VCR, connecting, 18 to 23
VGA computer cable, 13, 25
Video
  cables, 13 to 14, 18 to 23
  connecting video equipment, 18 to 23
  display settings, viewing, 60, 97
  formats, supported, 116 to 117
  selecting source, 32, 44
Video Signal setting, 58
Volume setting, 59
Volume, adjusting, 38, 59

W
Warning lights, 95 to 97
Warranty, 12
Web Control Password, 76
Weight, 114
Wired LAN setting, 76

Z
Zoom ratio, 113
Zooming image, 35, 45